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Abstract 

Geographic Information Systems (GIS) are powerful tools used by numerous industries, 

government agencies and increasinglyK-12 educators. GIS allows the display, storage, 

and analysis of spatial data. Educators are realizing the potential for these tools in their 

classroom in not only encouraging student inquiry and exploration, but also promoting 

student involvement in citizen action experience. Students are becoming involved in 

resolving real issues facing their communities. Yet, the infiltration of GIS into 

classrooms has been slow. This has been attributed to various reasons, including the lack 

of relevant curriculum, adequate training for teachers, and access to data. 

This project describes a curriculum development project incorporating GIS in 

Environmental Education (EE). To accomplish this task, a conceptual framework was 

constructed containing themes, key concepts, processes, skills, and learning objectives. 

The activities were developed using the conceptual framework as a guide. Background 

information was compiled, GIS data were located and step-by step instructions were 

written. Wisconsin model academic standards were correlated with each activity and 

included to assist educators. 

The resulting curriculum, Understanding Our Environment with GIS, consists of five 

lessons focused around two themes: 1) the distribution of species on Earth, and 2) the 

impact of humans on ecosystems. Included with the curriculum are the conceptual 

framework used in its development, correlation with the Wisconsin Model Academic 

Standards, an Arc View tool reference, a glossary, and a data CD-ROM. 

This project attempts to resolves some of the obstacles of implementing GIS in schools. 

Yet, further work needs to be done in providing training, developing more curriculum 

resources, and providing usable data for educators to feel comfortable using this 

technology in their classrooms. Hopefully Understanding Our Environment with GIS can 

be an impetus for this important work to get the power of GIS in the hands of students 

studying the environment. 
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Chapter 1 
Introduction 

Problem Statement 
The purpose of this project is to develop curriculum materials that use geographic 

information systems (GIS) to teach environmental concepts to middle and high school 

students. 

The Subproblems 
1. Develop a curriculum framework for the lessons using GIS for environmental 

education (EE). 

2. Develop activities that utilize the processes and skills that meet the student objectives 

and address the desired concepts. 

3. Identify the Wisconsin Model Academic Standards that are met by each of the 

activities. 

4. Develop professional development activities to share this curriculum with other 

middle and high school environmental educators. 

Significance of the Problem 
The goal of EE, developed in the late 1970's and early 1980's describes a progression of 

development towards creating environmentally responsible citizens. In order to achieve 

this, five subordinate goal levels were outlined (Unesco, 1978). The first, awareness, is 

developing awareness and sensitivity to the environment and its problems. The second, 

knowledge, aims to increase ecological knowledge and environmental issues knowledge. 

Attitudes, the third subordinate goal, is directed at analyzing the values and motivations 

one has about the environment and its issues. With skills development the fourth, 

participants acquire the necessary skills to recognize, analyze, and resolve environmental 

issues. The final subordinate goal, participation, encourages students to take an active 

role in the resolution of environmental issues (Engleson & Yockers, 1994 ). 

The use of GIS in the K-12 setting provides educators and students with another tool to 

help achieve these goals. GIS allows student-centered, inquiry-based problem solving. It 

allows students to analyze issues from a local to a global scale, recognize the motivation 

behind some of our current land use decisions and carefully plan for future, (ESRI, 1998). 
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In well-planned lessons the instructor can guide students through investigating issues, 

collecting appropriate data, analyzing the information, and acting on the knowledge 

gained to resolve the issue. 

In Wisconsin, the use of GIS as an instructional tool has been demonstrated at numerous 

conferences including Wisconsin Earth Science Teachers Association (WESTA), 

Wisconsin Association for Environmental Education (W AEE), Wisconsin Society of 

Science Teachers (WSST), and National Science Teachers Association (NSTA). It 

appears to spark the interest of vast numbers of teachers, yet its integration into the 

classroom is slow and sporadic. Dedicated individuals proceed through vigorous 

software training, and discover the steepness of the learning curve. According to an 

article about using GIS in a high school classroom, one researcher indicated that it takes 

approximately three years for applications to be successful in the classroom (Alibrandi, 

1997). 

As his technology slowly makes its way into classrooms across America, teachers are 

being trained in workshops and university courses (Kerski, 1999). Yet, there remains 

little written curriculum for the integration of GIS into K-12 instruction. Only two 

published works have been found to date. Studies have indicated that in order to increase 

the use of GIS in schools, curriculum will need to be developed that incorporates GIS 

with cross discipline learning is fun and intriguing (Mackaness, 1994). 
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Limitations 
1. This project will not attempt to determine the effectiveness of the lessons on student 

learning and accomplishment of the goals of EE. 

2. The publication and dissemination of the developed curriculum material is subject to 

the will of the publishing company. 

Definition of Terms 
Curriculum Framework 

The curriculum framework will be a guide used to write the curriculum to ensure 

a higher standard of quality. It will include curriculum themes, key concepts, 

learning objectives, and student processes and skills. 

Curriculum Resources 

Curriculum resources include any material that would serve to assist in the 

teaching of the content outlined in a curriculum. Materials could include videos, 

web pages, software, and printed material, such as activity guides or textbooks. 

Environmental Educators 

An environmental educator refers to any person or organization helping students 

to become more knowledgeable about the environment and skilled to live an 

environmentally responsible lifestyle. 

Geographic Information Systems (GIS) 

A GIS is a computerized way to organize, query, and analyze spatial data that is 

represented on a map. GIS allows users to assign attributes to any data point, line 

or polygon that could include any type of data. GIS users explore relationships 

between those attributes, and apply this information to countless problem-solving 

activities. 
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Professional Development 

Professional Development is any activity aimed at improving the knowledge and 

skills of an individual or group. Professional development activities include, but 

are not limited to, workshops, conferences, inservices, and courses. 

Assumptions 
1. Educators interested in using GIS or currently using GIS in their classrooms are 

looking for additional curriculum resources. 

2. Those same educators are interested in using lessons developed for environmental 

education. 

3. The developed curriculum will be accessible to the educators seeking it. 
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Chapter 2 

Literature Review 
Goals of EE 

The ultimate product of EE should be environmentally responsible behavior (UNESCO, 

1978). Environmentally responsible behaviors can include living one's lifestyle to have a 

minimal impact on the environment. It can also position students in places where they 

can make responsible decisions for the business that they work for, the community in 

which they live, or the world as a whole. 

In the Wisconsin Department of Public Instruction (DPI) publication, "A Guide to 

Curriculum Planning in Environmental Education (1994), Engleson and Yockers describe 

the subgoals to achieving this environmentally responsible behavior through K-12 

curriculum. The five identified subgoals of EE are: 1) increasing awareness about the 

environment and its issues, 2) increasing knowledge of ecological concepts and 

environmental issues, 3) teaching about attitudes and values associated with 

environmental issues, 4) developing citizen action skills, and 5) providing opportunity for 

citizen action experience. 

Status of EE 

Several authors (Disinger, 1989; Lucko et. al., 1982; Culen, 2001; and Hungerford and 

Volk, 1991) show that existing school curricula are inadequately addressing all of these 

subgoals. Awareness and knowledge are the foundations of what most EE curricula are 

built upon. While some schools may be doing an adequate job in teaching these areas, 

most fail to address attitudes and values, citizen action skills, and citizen action 

experience. 

Instruction about values is an important component to any child's development, not just 

in the development of environmentally responsible behavior (Nucci, 2004). The goal 

associated with values in EE indicates that students need to develop a set of values that 

allow them to make more responsible decisions, which in tum, help to preserve and 

protect the quality of the environment. 
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The aim of the citizen action skill goal is to help students develop the skills necessary to 

identify issues and seek their resolution (Engleson & Yockers, 1994). In order to become 

responsible citizens that can work through a logical process to solve problems, students 

need skills to locate resources, identify key players and their positions, recognize the 

players' values, determine a plan for action, and carry out action to accomplish 

resolution. Without problem solving skills and the tools necessary to tackle society's 

issues, students of today will be ill equipped to handle society's problems tomorrow. 

The purpose of the action experience goal is to get the students involved in issue 

resolution. It is here where they get to apply the skills and knowledge they have acquired 

to real environmental issues. Action experience gives students the opportunity to practice 

real citizenship. While this goal is probably the most important since it reflects the 

behaviors desired, it is also the most frequently absent from curricula (Culen, 2001). 

Applications of GIS 

GIS dates back to 1966 when Howard Fischer, an industrial architect, attempted to create 

an automated mapping system (Baker, 2002). The Harvard Lab for Computer Graphics 

and Spatial Analysis, where Fischer worked, had a significant impact on the development 

of GIS until the early 1980's. In the early 1980's Environmental Systems Research 

Institute (ESRI) released ARC/INFO, the first system to link a spatial database with 

objects on a map. ESRI has since been the leader in GIS software and applications 

(Hermansen, 2002). 

Many of the first users of GIS were government agencies interested in managing spatial 

data. The United States Census Bureau developed a system of encoding maps in the late 

1960's (Wisconsin State Cartographer's Office, 2001). GIS today remains a tool of 

government agencies in land use planning, natural resources and many other agencies. 

According to Johnson and Moore (1999), GIS applications have expanded in to many 

natural resource fields: 
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Because of its great analytical power, GIS is currently used a research and 
planning tool in a variety of industries including agriculture ( e.g. for precision 
planting and application of pesticides and fertilizer); environmental planning and 
research (e.g. to conduct environmental impact assessments and groundwater 
contamination modeling); forestry (e.g. to model wildfires and plan harvests); 
petroleum and mining exploration ( e.g. to identify potential locations of oil and 
mineral deposits); and many other industries. 

Indeed, the business sector has also found practical applications to identify locations of 

resources, plan marketing, and manage distributions. Additional applications in all 

sectors can be found in the book GIS for Everyone, (2000) 

Within the last fifteen years, GIS has become an invaluable tool for research. 

Universities and other research institutes are gathering data for analysis, 3D modeling, 

and planning for the future. Satellite imagery and global positioning systems (GPS) have 

increased the capacity for data acquisition. The limiting factor in the acceleration of 

GIS's application is the rate at which its users are able to develop appropriate inquiries, 

acquire the necessary data to formulate an answer, and apply the information to resolve 

the problem. 

GIS in K-12 Education 

The technology age has certainly driven the infusion of technological applications in the 

classroom. GIS is no exception. ESRI (1998), in GIS in K-12 Education, identifies the 

educational promise of GIS. The article identifies eight potential benefits of 

incorporating GIS into schools: 1) GIS can play a role in educational reform, 2) GIS is a 

vocational tool, 3) GIS engages and exercised multiple capacities and intelligences, 4) 

GIS relies on and fosters a mindset of exploration, 5) GIS relies on and promotes finding 

information and knowing what to do with it, 6) GIS relies on and promotes spatial 

awareness, 7) GIS relies on and promotes computer literacy, and 8) using GIS effectively 

requires knowing how to make the GIS software perform particular tasks. 

Many of these promises still need to be verified by expanded GIS implementation and 

continued research. Bednarz (1995), affirms that the majority ofresearch done on K-12 

GIS use has been anecdotal and conducted by the teachers using the technology. She 
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does however also conclude that the constructivist theories oflearning can be ideally 

facilitated by the use of GIS. 

Some authors have proven the power of GIS in student learning. The interactive and 

visual nature of GIS has been shown to increase student performance due to increased 

student motivation (Linn, 1995; Kerski 2001). In a controlled experiment involving three 

different high schools, GIS "fostered higher-order analytical and synthetic thinking" 

(Kerski, 2001). When used with students engaged in scientific inquiry, GIS enhanced 

student science process skills by improving data analysis techniques (Baker, 2002). 

Additional educational outcomes of using GIS in the classroom include the development 

of deeper spatial awareness, increased vocational learning, the development of group 

skills, and the potential to improve a local community. The use of GIS also provides 

"tangible artifacts of student learning," thus providing a means of authentic assessment 

(Coulter, 2003). 

GIS made its way into the classroom in the early 1990's when Robert Tinker showed the 

numerous "possibilities of representing data with digital maps in many curricula" with 

students in grades 4-6, (Baker, 2002). GIS is slowly making its way into courses in 

geography, computer science, environmental studies, social studies, the sciences and 

mathematics. ESRI (1998) identifies how GIS can be implemented at different grade 

levels, and in different subject areas. In GIS: A Sourcebook for Schools (2001), Green 

describes techniques for introducing GIS mapping to younger children. GIS in Schools 

(2000), provides several case studies outlining some of the applications of GIS in a K-12 

setting. 

As with any technology, there are some limitations and precautions that must be 

considered when introducing GIS to a curriculum. ESRI (1998), identified the following 

barriers: 1) insufficient hardware, 2) poor access to existing hardware, 3) lack of GIS 

software, 4) lack of usable data, 4) insufficient basic computer skills on the part of 

teachers, 5) inadequate GIS skills on the part of the teachers, 6) the steep learning curve 

for GIS, 7) lack of specific, relevant curriculum, and 8) pedagogical style not conducive 
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to using GIS, especially as an exploratory tool. Green (2001), Cheung and Brown (2001), 

Mackaness (1994), Kerski (1999), Kerski (2001), and Alibrandi (1998), all reiterate the 

same obstacles to implementing GIS in schools. 

According to a paper presented at the 1999 ESRI GIS Users Conference by Joseph 

Kerski, GIS technology has only been adopted by 2% of American high schools. Yet, he 

identifies the potential for "GIS to be one of the most promising means for implementing 

educational reforms" (Kerski, 1999). The same author also surveyed secondary teachers 

who owned a GIS software package to determine it utilization. More than half who own 

it do not use it. Only 20% of the teachers using GIS, use it with more than one lesson, in 

more than one class. There were twice as many science teachers as there were geography 

teachers using it. 

Mackaness ( 1994 ), indicates that the development of curriculum, gaining support of 

institutions using GIS and teacher training will all contribute to better utilization of the 

technology. Coulter (2003), says, "Teachers need strong curriculum materials ... and 

ongoing support in their use." Teachers who have already dedicated time to learning the 

software, lack adequate time to develop lessons (Kerski, 2001 ). The need for curriculum 

development is evident since there are only two known published curricula on the matter. 

Malone, Palmer and Voight (2001) wrote the first published curriculum, Mapping Our 

World: GIS Lessons for Educators. While it is an excellent tool for teaching the basic 

skills of using GIS and exploring geography, it directs the student investigations to a 

desired outcome. Community Geography: GIS in Action (2003), on the other hand 

offers a three-tiered approach to using GIS in schools. They first present a case study, 

highlighting the exemplary use of GIS in a classroom. They then guide students through 

an exercise exploring the same data that the students in the case study used. Finally, in a 

section called "on your own," they suggest possible investigations that could be 

conducted in your community using the same techniques as those used in the case study 

and guided exercise. 
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GIS in EE 

While the most obvious applications of GIS are in geography, mapping and analyzing 

geospatial data in the classroom lends themselves extremely well to utilizing GIS in EE. 

As Ramirez and Althouse (1995), indicate, GIS provides "an interesting format to 

promote solutions to critical environmental and earth issues on a state, national, and 

global scale." Students involved in exploring their world with GIS have the tools to see 

the world as it is, or predict what it might become if certain parameters are manipulated. 

Individual projects provide examples of how GIS can accomplish many of the needs of 

EE. Dillon and Lemar (1999), presented a program in the City of Phoenix to actively 

involve youth in service learning and community problem solving. Filson (1998), 

describes GIS as providing assistance to help students develop a sense of place. Bridges, 

et. al. (1999) and Alibrandi (1998), show how GIS can be used in collaborative projects; 

getting students involved in citizen action experience. Walker, et. al. (2000), describe the 

role of GIS in making decisions concerning natural resources, and provide some 

classroom activities utilizing GIS. Baker and Case (2003), explain how students are 

collecting data and developing a better understanding of global warming. Culpepper 

(2003), shows how students in Arkansas are studying population growth by identifying 

areas of high growth. 

Summary 

The goals of EE cannot effectively be met through current methods and practices in K-12 

institutions. Students need to be involved in real applications of their knowledge and 

skills. GIS can be used effectively as a tool in EE to accomplish this task. The barriers 

to using GIS in a K-12 setting can seem rather cumbersome to overcome. Dedicated 

teachers who go out of their way to obtain training, write grants, develop projects and 

engage students have experienced great success in using GIS. Numerous case studies 

illustrate how their students are collecting data and using it make a difference in their 

communities. Efforts are needed to assist these teachers and students in staying on top of 

a rapidly evolving technology and make learning meaningful. 
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Chapter 3 

Methodology 
Introduction 
This section will outline the practices and procedures that will be used in developing 

curriculum resources that use GIS for environmental education. This will be addressed 

through the subproblems listed below. 

Subproblem #1 - Develop a curriculum framework for the lessons using GIS for 

environmental education (EE). 

The process of developing lessons using GIS for EE will begin with the creation of a 

curriculum framework. This framework will include elements such as themes, key 

concepts, learning objectives, and student skills and processes. The purpose of this 

framework will be to guide the development of the lessons to ensure that all areas of 

environmental education are given equal emphasis and to ensure that the curriculum is 

thorough. The goals of EE and Environmental Education Materials: Guidelines for 

Excellence will be used to ensure that the framework and subsequent curriculum meet the 

needs and expectations of environmental educators (North American Association for 

Environmental Education, 1996). 

The development of the conceptual framework will begin with the themes. Themes will 

be developed that address the spatial distribution of organisms on Earth and for the 

impact of humans on the ecosystem. The lesson ideas will then be generated. A list of 

process will be written for each of those themes that identify exactly what the students 

will be doing. From the processes a list of skills for each process will be generated that 

focus on higher cognitive skills. Finally, student learning-objectives will be defined for 

the exact products of the processes. 
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Subproblem #2 - Develop activities that utilize the processes and skills that meet the 

student objectives and address the desired concepts. 

Working from the themes, and key concepts in the framework, individual lessons will be 

developed to meet the desired learning objectives and incorporate the desired skills and 

processes. Each lesson will include a teacher page with an overview of the lesson, lesson 

details (i.e. intended grade level, materials & time needed, etc.), a thorough background 

section, assessment components, and suggested extensions. If the students are not 

collecting their own data for a lesson, and it is not easily accessible via the Internet, the 

data will be provided on a CD. Data will be acquired from various sources on the 

Internet, state and local governments, as well as other private industries. The student 

procedures will be written in a format ready to be distributed to the students. The 

instructions will be complete with diagrams to assist students with the use of the GIS 

software, Arc View. Finally, formatting will be done to make the curriculum ready to 

distribute, including a table of contents, and glossary. 

Subproblem #3 - Identify the Wisconsin Model Academic Standards that are met by 

each of the activities. 

Wisconsin Model Academic Standards for all core subject areas, technology, and 

environmental education will be collected and reviewed. Standards met by the activities 

will be identified and listed in a chart in the appendix of the curriculum. 

Subproblem #4 - Develop professional development activities to share this 

curriculum with other middle and high school environmental educators. 

Activities from the curriculum will be presented at upcoming conferences. At the 

Wisconsin Association for Environmental Education (W AEE) Fall 2004 Conference a 

session will be presented on using GIS in your school forest. Lessons incorporating 

student collection of data will be highlighted. Additional presentations will be scheduled 

for the Wisconsin Society of Science Teachers (WSST) spring 2005 convention, and the 
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2005 ESRI Education User Conference. Initial printings of the developed lessons will be 

done to distribute to teachers at conferences. ESRI Press and other publishers will be 

contacted about potential publication. Additional workshops and possibly courses 

offered for credit will be explored for the summer of 2005. A web site will be developed 

to provide ongoing assistance with any teachers using GIS in their classrooms. It will be 

a place where educators can share information about what works and what doesn't, share 

data and additional curriculum resources, and where online professional development 

resources can be offered. 
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Chapter 4 
Results 

The curriculum developed for this project, called Understanding Our Environment With 

GIS, can be found as the Appendix. It consists of five lessons, each of which 

incorporates some form of GIS with an inquiry into some environmental concept. They 

are designed to be used either as stand-alone lessons or combined for an entire unit. Each 

lesson assumes that the students have had no previous experience using GIS. However, a 

basic understanding of what GIS is would be helpful. Included with the curriculum are 

the conceptual framework used in its development, correlations with the Wisconsin 

Model Academic Standards, a glossary, and a data CD-ROM. 

Subproblem 1 - The Conceptual Framework & Assessment 

The conceptual framework for Understanding Our Environment With GIS was developed 

and included with the curriculum to assist educators in their own planning (see 

Appendix). In this age of accountability educators need to justify their curricula to their 

administration, school boards and the community. Included in the conceptual framework 

are two themes: 1) The Distribution of Species on Earth, and 2) Human Impacts on the 

Ecosystem. These themes were identified by listing potential environmental topics that 

could be taught using GIS. Topics were located by browsing environmental science 

textbooks. These topics were then lumped into categories or themes based on the overall 

focus of the lesson (e.g. energy, forestry, human population, distribution of species, 

human impact on the ecosystem). The themes represented by this curriculum were not 

the only themes that appeared in the listing. The others should be developed and 

expanded upon the future. 

Also included in the conceptual framework are key ecological concepts that are covered 

by each lesson. These can be helpful for teachers seeking a lesson to address certain 

concepts. The final component of the conceptual framework is a chart outlining the 

processes, skills, and learning objectives for each lesson. The processes are a list of 

exactly what the students will be doing (e.g., creating a map, drawing a graph). The 

skills identified are those needed to accomplish the various processes. This list of skills 
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can be very helpful in assessing student progress and abilities. Each lesson requires 

student to compile materials for a portfolio performance assessment, since it is believed 

that the products of true learning are found in the work conducted by the student. In 

addition each lesson contains a skills rubric to be completed by the student and the 

teacher. Finally, the learning objectives assigned to each lesson identify the outcomes of 

each lesson. 

Subproblem 2 - The Lessons 

Understanding Our Environment With GIS consists of five lessons within the two themes 

described above. Within the realm of the first theme (i.e., The Distribution of Species on 

Earth) are the first three lessons: 1) Where In The World?, 2) Disappearing Reefs, and 3) 

Tracking Sea Turtles. The final two lessons, Estimating Impervious Surfaces, and 

Monitoring A Watershed, focus on the Human Impacts on the Ecosystem, the second 

theme. Each lesson begins with a background section that introduces the topics studied. 

The procedures for the lesson are included with full step-by-step instructions to allow 

novice GIS users the same success with the lesson as an experienced user. Each lesson 

concludes with a list of websites related to the topics in the lesson, a portfolio planner, to 

help students assemble their work, and the skills rubric assessment. 

In the first lesson, Where in the World?, students learn about biomes by exploring the 

distribution of species on earth, examining the range of several tree species, and 

discovering how humans impact where organisms live. Students research a specific reef 

to discover the threats that reef ecosystems face in the second activity, Disappearing 

Reefs. In Tracking Sea Turtles, the third lesson, students learn about sea turtles and 

tracking wildlife. They plot satellite telemetry locations for several sea turtles and write a 

travel journal for that turtle. In the fourth lesson, Estimating Impervious Surfaces, 

students download aerial photographs from the Internet, estimate the imperviousness of 

their school property and continue that analysis throughout their community. In the final 

activity, Monitoring a Watershed, students conduct water quality tests and analyze land 

use patterns in an effort to monitor the health of their watershed. 
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Data for use in the Lessons 

Acquiring usable GIS data is a challenge for most educators. The data must be in a 

format compatible with the software being used. They must be projected in the same 

datum and coordinate system. Originators of data typically use a projection that creates 

the least amount of distortion for their locale. Each agency creating data has a standard 

that they use for coordinate systems, but they are seldom the same. This curriculum 

removes some of that complexity by providing data for three of the lessons: 1) Where In 

The World?, 2) Tracking Sea Turtles , and 3) Monitoring a Watershed. The other two 

lessons provide instructions for acquiring the data from the Internet. At this time data for 

Monitoring A Watershed are only available for Wisconsin. As more data become 

available they will be provided via a web site. All data are referenced within the lesson 

they are used with. 

Subproblem 3 - The Standards 

Standards from the Wisconsin Model Academic Standards were correlated in a chart for 

each of the lessons. Academic areas included in this correlation included the core 

subjects (language arts, mathematics, social studies, and science), EE, and information 

technology. The chart simply identifies the standards which were addressed, not the 

degree to which they were addressed. The standards correlation can be found in the 

appendix of Understanding Our Environment With GIS (see Appendix). The five 

activities address a total of 111 Wisconsin model academic standards. Twenty-nine of 

these were EE standards, 25 were science standards, 16 were information technology 

standards, 15 were language arts standards, another 15 were social studies standards, and 

11 were mathematics standards. 

Subproblem 4 - Professional Development 

The promotion of Understanding Our Environment With GIS, will begin in the fall of 

2004 with a presentation at the fall Wisconsin Association for Environmental Education 

(W AEE) conference. Teachers attending the session will receive a copy of the 

curriculum, conduct field work pertaining to the lessons, and be asked for feedback for 

improving the lessons. A second presentation will be scheduled for the annual Wisconsin 
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Society of Science Teachers (WSST) convention in the spring of 2005. An additional 

national presentation will be delivered to the Environmental Systems Research Institute 

Educational Users Conference upon incorporation of teacher feedback. Progress has 

been made on the development of a web page to be used as support. It should be 

available by spring of 2005. The publication of this curriculum will be delayed until 

teacher feedback is incorporated and additional lessons are developed. 
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Chapter 5 

Conclusions and Recommendations 

Based on this project the following conclusions and recommendations can be drawn: 

Subproblem 1 - The Conceptual Framework & Assessment 

Conclusions: 

The development of a conceptual framework guided the process of the 

development of the entire curriculum for this project. A conceptual framework 

allows the developer to stay focused on the desired themes and concepts. In 

addition, the processes, skills and objectives are helpful to the instructor wishing 

to use the curriculum. They provide assistance with the selection of the 

appropriate lesson, assessment, and accountability. 

Recommendations: 

Gathering input from others can be useful at this stage to ensure a well-rounded 

curriculum. The conceptual framework for Understanding Our Environment With 

GIS was developed only by this author. It is felt that a better curriculum could 

have been developed with the input of others during this stage of its development. 

The use of a table for organizing and displaying the processes, skills and 

objectives allows for easier readability and usefulness. 

Subproblem 2 - The Lessons 

Conclusions: 

GIS has a natural fit with EE curriculum. Both focus on encouraging exploring 

and understanding the world around us. GIS provides environmental educators 

with another tool to help students build, not only research skills, but also action 

experience. Students across the country are using GIS in their classrooms, 

learning environmental content, and making a difference in their community, and 

in the world. 
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Recommendations: 

Instructors should focus on using lessons with GIS that study local environmental 

issues in addition to those of a global scale. This allows greater opportunity for 

action experience in resolving the issue. Additional lessons should be developed 

for other areas of environmental studies to complement those in Understanding 

Our Environment With GIS. Lessons from all aspects of environmental science 

can and should be explored. Students can use GIS for exploring human 

population issues, energy, forestry, soils, pollution, wildlife, land use, obtaining 

natural resources, and countless others. Curriculum written to help break down 

some of the barriers to the use of GIS in the classroom should include step-by

step instructions and provide data for use with the lessons. 

Subproblem 3 - The Standards 

Conclusions: 

The correlation of standards in this curriculum development allows for easier use 

by educators who must align their lesson plans with these standards. While some 

educators believe that EE belongs only in science curricula, standards were 

identified for the lessons in Understanding Our Environment With GIS in all core 

curricular areas as well as informational technology. 

Recommendations: 

Correlation with standards should be completed for all curricula developed for 

using GIS in EE. This correlation should include all applicable state and national 

standards. It is also recommended that the depth of coverage also be included. 

Subproblem 4 - Professional Development 

Conclusions: 

Conference presentations of Understanding Our Environment With GIS, will 

allow for its distribution to teachers for piloting in classrooms. Publication will 

increase distribution once feedback has been used to improve the curriculum. 
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The incorporation of GIS with EE in the K-12 classroom still has numerous 

obstacles to overcome. Teachers without the skills and ability to use GIS 

comfortable on their own will not use it with their students. 

Recommendations 

Providing training, curriculum, and data for teachers will most likely have the 

greatest impact on increasing GIS utilization in schools. Continuous support for 

teachers will need to be provided to keep them up to pace with industry and help 

them through any struggles they run into. Teaming teachers up with universities, 

industries, and local agencies using GIS would provide this support network. 

The use of GIS in K-12 instruction seems likely to continue and expand. There are 

countless ways that GIS can improve education. The exploratory nature of GIS puts the 

students in charge of their own learning. When students explore their own community 

with GIS they build stronger bonds to that community and may act in more positive 

regard towards it. GIS encourages student inquiry. When students get started working 

with GIS they begin to ask for data that are not yet available which encourages them to 

collect them on their own, fostering their own scientific learning experience. Due to the 

fact that countless industries are now utilizing GIS, incorporating it into K-12 instruction 

makes it a vocational tool. 

The implementation of GIS for EE instruction is in its infancy. During this early stage 

educators need to become involved in shaping how this powerful technology can be 

utilized. In classrooms across America, students are making discoveries never dreamed 

possible. More importantly, they are becoming involved in resolving issues that arise 

because of their investigations, thus addressing that ultimate goal of EE; Citizen Action 

Experience. Hopefully, this curriculum development project serves as a springboard for 

educators to jump into the world of GIS and involve their students in understanding their 

environment. With the understanding, will come stewardship. 
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Introduction 

Geographic Information Systems (GIS) are powerful tools used by numerous 

industries, government agencies and increasingly K-12 educators. GIS allows 

the display, storage, and analysis of spatial data. Educators are realizing the 

potential for these tools in their classroom in not only encouraging student 
inquiry and exploration, but also promoting student involvement in citizen 

action experience. Students are becoming involved in resolving real issues 

facing their communities. Yet, the infiltration of GIS into classrooms has been 

slow. This has been attributed to various reasons, including the lack of relevant 
curriculum, adequate training for teachers, and access to data. 

This curriculum is the result of a project to incorporate GIS in Environmental 

Education (EE). To accomplish this task, a conceptual framework was 

constructed containing themes, key concepts, processes, skills, and learning 

objectives. The activities were developed using the conceptual framework as a 

guide. Background information was compiled, GIS data were located and step
by step instructions were written. Wisconsin model academic standards were 

correlated with each activity and included to assist educators. 

The resulting curriculum, Understanding Our Environment with GIS, consists of 

five lessons focused around two themes: 1) the distribution of species on Earth, 
and 2) the impact of humans on ecosystems. Included with the curriculum are 

the conceptual framework used in its development, correlation with the 

Wisconsin Model Academic Standards, a glossary, and a data CD-ROM. 

This project attempts to resolves some of the obstacles of implementing GIS in 
schools. Yet, further work needs to be done in providing training, developing 

more curriculum resources, and providing usable data for educators to feel 

comfortable using this technology in their classrooms. Hopefully 

Understanding Our Environment with GIS can be an impetus for this important 

work to get the power of GIS in the hands of students studying the 
environment. 



Where /n The World? 
Explore the distribution of species on Earth. Examine the 
range of several tree species. Discover how humans can 

impact were organisms live. 



Materials: 
• Computers w/ internet access 
• ArcView GIS 
• GIS Data 
• Color Printer 
• Copies of this Lesson 
• Copies of the Skills Rubric 

-

W Vocabulary 

Natural Selection - The process 
where the conditions in the 
environment determine which 
organisms will survive & 
reproduce 

Endemic - A species that is 
limited in distributions to only one 
location 

Overview: 

'A thing is right when it tends to 
preserve the integritgJ stabi/itgJ and 
beautg of the biotic communitg. /tis 

wrong when it tends otherwise.» 
Aldo Leopold 

When one travels to other parts of the world he or she makes an 
astounding discovery ... "Different regions of the world are different." 
While there may be some similarities, the number of differences is 
certainly greater. Obviously the culture and languages may be different. 
Do you hear the same birds or see the same plants? This lesson 
explores some of the reasons why different species are found in different 
places in the world. You will use GIS to plot the distribution of a few tree 
species in North America and then seek to find the reason why they live 
where they do. In the end, you will be challenged to think about the 
impact humans could and do have on the distribution of life on Earth. 

Background: 

Think about the animals that you might find living in a woods near 
your house. I bet you weren't thinking about a polar bear, were you? 
Why not? Why don't polar bears live around here? What kind of habitat 
do they live in? Why is that habitat not found here? Plants are the same 
way. You don't find too many banana trees growing in Wisconsin! 

All living things have become adapted to making a living in certain 
places. Through ages of evolution by means of natural selection 
species have become capable of living on almost every corner of this 
planet. Adaptations that allow one species to flourish in the desert are 
useless to other species living elsewhere. When conditions change in an 
ecosystem organisms can adapt to those changes, relocate to a 
favorable environment, or fall to the process of natural selection. 

Species that have a high tolerance for change tend to be 
generalists. They accept a wide variety of conditions for living. 
Therefore their distribution is greater. On the other hand, species that do 
not tolerate change typically have a set of very specific conditions that 
must be present for their survival and ultimately have a very narrow 
distribution. Species found only in one region are called endemic. 
Conservation of endemic species is extremely important in preserving 
biodiversity. To do so biologists must focus on protecting the ecosystem 
and not the species. Placed in an altered ecosystem survival for these 
species is uncertain. 



/ So what is it that makes one place habitable and another 
inhabitable. In the space below list several biotic and abiotic 
factors that may influence where an animal lives. 

Biotic Abiotic 

Scientists have used two of those characteristics to define 
regions of the world that have certain vegetation types and animal 
species. The regions are called biomes and the characteristics that 
define them are precipitation and temperature. The graph below shows 
how all of the biomes fit together within temperature and precipitation 
ranges. 
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/ Which biome receives the most precipitation? 

/ Which has the highest mean annual temperature? _______ _ 

/ Which biome receives only 100 cm of annual precipitation and has an 
annual mean temperature of 0 °C? _____________ _ 

/ Which 3 biomes might be considered extreme? 

/ Should global warming take place and not affect the precipitation, a 
temperate deciduous forest receiving 100 cm of precipitation would most 
likely convert to which biome? -------------

blJ Vocabulary 

Abiotic - Non-living 

Biome - A geographic region with 
similar climate and species 
composition 

Biotic - Living 



W Vocabulary 

Climatogram -A graph that 
displays the average monthly 
precipitation and the average 
monthly temperature. 

Project -An Arc View file that 
organizes your data & products 

1-tJI Select Feature 

I 

Exploratory Activity - Exploring the Climate in Different Biomes 

Scientists can summarize the 
important climatological data for a biome 
by using a climatogram. The 1 

climatogram displays a graph of both the 
average monthly temperature and the 
average monthly precipitation. In this first 
activity we will explore the climate in each 
of the major land biomes found in the 
United States and produce generalized 
climatograms for each biome. These are 
useful in predicting what an ecosystem 
looks like only by knowing what the 
climate is. 

1. Open ArcView. If prompted to create a new project or open an 
existing project choose to open an existing project. If you are not 
prompted, click the File menu and choose Open Project. 

2. Navigate to the Understanding Our Environment with GIS directory 
(See your instructor for the path), open the Biome folder open the 
Biome.apr file. 

Your screen should open with a map of the United States and two graphs 
that together look similar to a climatogram. Each dot on the map 
represents a city for which climatological data are available. One dot on 
the map should be highlighted yellow (Duluth, MN). This is location for 
the data that you see in the graphs. We will begin by simply exploring 
the data available. 

3. Click the title bar for the map to make that window active. Click the 
Select Feature tool to select another city. Each time you click on 
another city that data presented in the graphs changes. If you 
accidentally miss a city your graph will display, "Too much data. 
Please select fewer rows." Simply click another city to update your 
graph. If you click on two cities that are very close together the 
graph may display both sets of data. This will be useful later on in 
this unit. 

4. If it helps to zoom in to click the dots that you wish use the following 
zoom tools to help you navigate ... 

© Zoom In [!!] Zoom In (without click & drag) 

Zoom Out l~~I Zoom Out (without click & drag) 

Pan - Move side-to-side or up & down 

Zoom to Fu II Extent - Zoom out all of the way 

Zoom to Active Theme(s) - Zooms to the selected theme 

Zoom to Selected - Zooms to the highlighted feature 

~ ----------~---Z-o-o~m~ to~ P-re_v_i_o~u-s_-_Z~o-o-m~s- t-o~t-h-e~e-xt- e-nt- p~re-v-io_u_s~l-y-d-is_p_l_ay_e_d-~--



5. Zoom in to the East Coast. Click the Find tool. Type in Caribou and 
click OK. Notice That Caribou, Maine is highlighted. Work your way 
down the East Coast, clicking on different cities one at a time. Watch 
what happens to the graphs. 

/ Over all what happens to the temperature curve? 

/ Do you notice any significant change in the precipitation? 

/ Why does the temperature curve flatten out the farther into Florida you go? 

6. Use this method moving east to west. 

/ What trends do you see? 

7. Turn on the Biomes theme by clicking the box to the right of the 
theme name in the Table of Contents. This displays the location of 
the different biomes present in the United States. While not all of the 
biomes are found in the US, our country is relatively diverse. 

8. Examine the climatograms for the cities within each of the major 
biomes found in the US (listed below). 

/ Select a representative city for each biome that represents the 
climatological conditions found throughout the biome. List those 
cities below. 

Biome Representative City 

Boreal Forest (Alaska) 

Desert & Xeric Shrubland 

Temperate Broadleaf & Mixed Forest 

Temperate Coniferous Forest 

Temperate Grasslands, Savannas, & Shrublands 

Tundra 

9. Select one of the cities you have selected for the Boreal Forest. 
Under the Window menu select Biome Climatograms, This will open 
a layout window displaying the climatogram for the city that you have 
selected. 

10. Click the Pointer button and double-click on the text that says 
"Biome: & Representative City." When the Text Properties Window 
opens type in the name of your biome & representative city after the 
colon. 

l®.I Zoom In 

[HJ Find 

ffi Vocabulary 

Theme -A set of related 
geographic features in point line 
or polygon format 

Layout - An arrangement of map 
elements for printout or digital 
display. 

-e{f Biomes 
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W Vocabulary 

Biogeography - The study of 
species distribution 

11. Select Print ... from the File Menu. Click Setup to change your print 
settings or select a printer. (Print to a color printer if one is 
available.) Click OK to send the layout to the printer. 

12. Repeat this process for each of the major biomes in the United 
States. Unfortunately, once you go back to the map to select another 
city the first one is altered. Be sure you print a copy before changing 
your location! 

13. When you are finished, do not save, and close ArcView. 

14. Test your skill at Identifying the biomes online at Kingsburg High 
School's Match the Biome Game (See Web Links for the address). 

Application Activity - Determining limiting factors in a species distribution. 

Unfortunately human population growth and our need for more 
and more natural resources will most likely never disappear. All 
ecosystems of this earth are in danger of eventually succumbing to the 
alteration of humans. As we plunder the Earth we will no doubt displace 
countless species. Developing an understanding of a species needs 
will be critical if we truly wish to preserve their place in evolutionary 
history. 

Global climate change driven by the excessive burning of fossil 
fuels appears to be one of the most significant impacts that humans 
may have on the face of this planet. Changes in global temperatures 
affects all aspects of climate. As we have already seen ecosystem 
composition is dependent primarily on temperature and precipitation. 
Significant changes in these factors can cause entire ecosystems to 
shift. 

Scientists have already begun plotting the distribution of different 
species on Earth. The science of biogeography explores these 
distribution patterns. In this activity you will play the role of a 
biogeographer. It is your task to determine whether it is temperature, 
precipitation or neither that determine where several species of North 
American trees can be found. You will also be asked to predict what 
will happen to the range of those species should the predictions of 
global warming come true. 

1. Open ArcView and the Biome project. Maximize the Biomes of North 
America view. 

2. Turn off the City Climate theme by clicking the checkmark next to the 
theme name in the Table of Contents. 

3. Below the different Biomes are several species of trees found in 
North America. Explore these themes by turning them on & off. If 
you have difficulty seeing them use any of the zoom tools that you 
used earlier. 

/ Choose five of these tree species that are located in different parts of 
the United States to analyze their distribution. List them in the table 
on the next page. 



Tree Species Biomes Temperature Range Precipitation 
Range 

Level of Threat 



•~ SelectBylheme _______ - ~ 

r-;-~ features cl act:themes !hat 

!Intersect ..£1 New Set 

I 
j the ;elected fealties ol 

Wii .... 1 

AddloSel 

SelectlromSet 

[once! 

!ill I Open Theme Table 

!~I Promote 

4. Turn on your five tree themes by clicking the box in front of the 
theme name in the Table of Contents. Be certain that the species that 
you have selected do not overlap too much. 

You are now going to use the power of the GIS to help you determine 
which biomes the tree is found in. 

5. Click the Biome theme once in the table of contents to make it active. 
Be careful not to turn it on. In the Theme menu choose Select By 
Theme. You want to select features that Intersect one of your tree 
species. Then click New Set. 

Your map will not look any different when you are finished . That is 
because the features that were selected are on the Biomes theme that 
is not being displayed. You may turn on that theme to see what was 
selected, but it is impossible to know if more than one biome was 
selected by viewing them on the map. Instead we are going to look at a 
table of the biomes. If you turned on the biomes theme, please turn it 
off, but be sure it is still active. 

6. Click the Open Theme Table button to display the data table for the 
Biomes theme. Maximize the window. To see which biomes have 
been highlighted that intersect with your selected tree species click 
the Promote button. This will move all of the highlighted biomes to 
the top of the table. 

/ You should be able to scroll down the list and see which biomes that 
tree species can be found in. List the biome types in your table. 

/ What does it mean if there is primarily only one biome listed? 

/ While you are in the table window you can also record the level of 
threat for your tree species. In the last column "Final" is a value that 
represents the final estimation of the threat to that ecosystem in the 
next 20 years according to the World Wildlife Fund. The meaning of 
the values can be found in the table below. Record the average value 
for the highlighted biomes in your table. 

1 Critical in estimated threat over the next 20 years. 

2 Endangered in estimated threat over the next 20 years. 

3 Vulnerable in estimated threat over the next 20 years. 

4 Relatively stable in estimated threat over the next 20 years. 

5 Relatively intact in estimated threat over the next 20 years. 

0 Not assessed or unknown. 

7. Close the table window to return to you map. (Be careful not to close 
Arc View!) Repeat this process for all five of the tree species that you 
have selected. 



8. To determine the temperature and precipitation range that your tree 
species prefers we will be using a scatter plot. Click the City Climate 
theme name in the Table of Contents once to make it the active 
theme. In the Theme menu choose Select By Theme. Just as before 
we are interested in features that intersect our tree species. Click 
New Set. 

9. This time when you return to your map & graphs, if the number of 
cities with climatological data within the range of your species is less 
than ten you will see several lines in your climatogram. However to 
see the range select Annual Temperature & Precipitation from the 
Window menu. This will open the scatter plot. Minimize this window 
when you are finished. 

/ Record the approximate temperature and precipitation range for this 
species. If all of the points in the scatter plot are very close together 
this species is not very tolerant of a wide range in temperature & 
precipitation. If they are scattered the species is more of a generalist. 

10. To print a copy of your scatter plot for each tree species select 
Temperature & Precipitation Range from the Window menu. This 
opens the layout window for the scatter plot. Maximize this window. 

11. Click the Pointer button and double-click on the text that says 
"Species:" When the Text Properties Window opens type in the 
name of your tree species aher the colon. 

12. Select Print. .. from the File Menu. Click Setup to change your print 
settings or select a printer. (Print to a color printer if one is 
available.) Click OK to send the layout to the printer. 

13. Minimize the layout window to continue. Repeat this process for 
each of the major biomes in the United States. Unfortunately, once 
you go back to the map to select another city the first one is altered. 
Be sure you print a copy before changing your location/ 

** If you accidentally close any of the windows instead of minimizing 
them select biome.apr from the window menu. Click on the type of 
window you want open (I.e. layout, chart, etc) and double click the 
correct window. 

/ Which of your tree species has the narrowest range for temperature? 

/ Which has the narrowest range for precipitation? 

/ Overall, which species has the most specific climate requirements? 

/ Which has the most general climate requirements? 

[!] Pointer 



/ Earlier we listed other factors that may limit a species distribution. Which 
of these do you think applies to the trees that you studied? 

/ Of the tree species that you studied, which lives in an ecosystem that is 
most at risk? (1 =Most Critical.. .5=1ntact) 

/ Which is least at risk? 

/ Global climate change will not have the same effect everywhere on the 
planet. Some regions may experience drought while other floods. Based 
on your research do you feel that the species listed most at risk by the 
World Wildlife Fund is in danger of going extinct? Why or why not? 

/ Explain how plants might respond to a shift in climate patterns. How would 
their response differ from animals? 

/ Does is really matter? Climates have changed numerous times in the 
history of life on earth. Should we try to preserve biodiversity as it exists 
today or let it chart some new course for the future of life on Earth? Please 
explain your answer in a one page essay. 



Web Links: 

~ Biogeography Lab-University of California Santa Barbra 
http.llwww.biogeog.ucsb.edu/ 

~ Checklist of Online Vegetation and Plant Distribution Maps 
http://www.lib.berkeley.edu/EART/vegmaps.html 

~ Climate Change Atlas for Tree Species of the Eastern United States 
http:llwww.fs.fed.us/neldelawarelatlasl#Launch%20the%20atlas 

~ Early Classics in Biogeography, Distribution, and Diversity Studies 
http.llwww. wku.edul~smithchlbiogeogl 

~ GLOBE Presents - Kingsburg High School's Match the Biome Game 
http.Jlwww.globe.gov/fslleventsA1elsinki2A1elsinki/biomelnoframes_game.p/?lang=en&nav=1 

~ National Climatic Data Center 
http.llwww.ncdc.noaa.gov/oa/ncdc.html 

~ National GAP Analysis Program 
http.1/www.gap.uidaho.edu/default.htm 

~ World Biomes 
http.llwww. worldbiomes.coml 

~ World C Ii mate 
http://www. worldclimate.coml 

Portfolio Planner: 

Compile the following in portfolio format. .. 

~ Layout Displaying Climatograms For The Six Major US Biomes 

~ Your Data Table For Your Five Tree Species 

~ Layout Displaying Scatter Plots For Your Five Selected Tree Species 

~ Your One Page Essay on Why or Why Not Preserving Species 
Distribution is Important 

~ A Self Evaluation - Mapping Biomes Skills Rubric 

References: 

~ Tree Distribution Data 

U.S. Geological Survey. (1999) Digital representation of "Atlas of United 
States Trees" by Elbert L. Little, Jr .. [Online] Available: http://climchange.cr. 
usgs. gov/ data/atlas/little/ 

~ Biome Graph 

Purves et al. (1995) Life: The Science of Biology, 4th Edition, Sunderland, MA: 
Sinauer Associates & WH Freeman. 



Mapping Bi1omes Skills Rubric 

Skill Excellent Good Needs 
Improvement 

Interpret a graph I am able to answer any I can answer most questions I'm not sure what the graph 
(pg. 4) question you throw at me! you give me about the graph. means at all! 

Summarizing data I have selected the city that I selected a city that sort of I have selected a city that does 

(pg. 6) 
best represents the climate represents the climate data for not represent the climate data 

data for this biome. this biome. for this biome. 

Creating a layout The layout was done even 
I followed the directions and 

I could not follow the directions completed the layout as 
(pg.6&10) before you assigned it! 

assigned. 
or did not complete the layout. 

Selecting features 
I am now an expert feature I followed the directions and I could not follow the directions 
selector! While you were selected the features as or did not select the correct 

(pg. 9) talking I selected a few other 
assigned. features . 

just for fun! 

Analyze spatial I created and understood the 
I created the scatter plot, but I 

What we had to do a scatter 
relationships (pg. 10) scatter plot completely. 

am having a hard time 
plot? What is that? understanding what it means. 

I am able to open the theme 
I can find my way around the I can't find the theme table? Explore attribute data table, organize the information 

theme table and find the What are all of those numbers 
(pg. 9) in numerous ways and tell you 

information needed. for? 
what it all means. 

Give me the average 

Evaluate data temperature and precipitation I am able to make some I am unable to tell you where 

(pg. 10) 
anywhere in the world and I can predictions about a couple of you will find any trees. Try the 
tell you what trees you will find trees. forest! 

there! 

Inferring outcomes Should global warming take I can make some predictions 
I am unable to predict how 

(pg. 10 & 11) 
place, I know just how the world about how species distribution 

species distribution will change. 
will look. will change. 

Developing an opinion I feel very strongly about this I am not sure which way I feel. I really don't have an opinion. 
(pg.11) and here is why ... 



Disappearing/?eefs 
Tour a coral reef without leaving your classroom. 

Investigate issues facing reefs around the world. Develop 
an action plan to protect a specific reef. 



Overview: 

Disappearing I\ eefs 

11The ultimate test of man's 
conscience mag be his wiHingness to 
sacrifice something todag for future 
generations whose words of thanks 

will not be heard 11 

- Ga9lord Nelson 

Coral reefs like many other ecosystems in this world are under 
Materials: pressure from the impact of humans and natural events. While most of 
• computers w/ internet access you might never get the opportunity to see coral reefs first hand, you 
• Microsoft PowerPoint I can gain an appreciation for them by studying their wonder and learning 
• Color Printer about their peril. This lesson is designed to get you exploring coral 
• Copies of this Lesson reefs using the Internet and GIS. Although you may never leave the 
• Copies of the Rubric classroom, you will dive deep into the issues affecting reefs so that you 

may see how wondrous these ecosystems are and hopefully be 
encouraged to help in their protection . 

Background: 

Coral reefs have been called the rainforests of the ocean. They 
are by far one of the most diverse ecosystems on Earth. While they 
take up only a small fraction of the ocean, they harbor the majority of its 
species. Globally these ecosystems provide countless services to the 
ecosystem and people. Whether providing food directly or by 
supporting the people through the tourism industry, reef support many 
developing economies. Barrier reefs protect many islands from the 
damaging pounding ocean. By providing food and shelter, the coral 
itself supports these magnificent ecosystems. 

In this activity you will research a specific coral reef somewhere 
in the world. You will discover the importance of that reef as you 
explore the geological, geographical, biological and social features of 
that reef. You will examine the threats to reef ecosystems as you 
determine the health of your reef. As you research what is being done 
to protect reefs you will develop an action plan for your reef and the 
people of its mainland. In the end you will educate your classmates 
about your reef through a PowerPoint, poster, brochure, video, or web 
page. 



The online coral reef GIS that students will use for this activity is 
ReefBase located at www.reefbase.org. ReefBase is designed to be a 
central data collection for coral reefs, their health, monitoring and 
management. It is intended to be used by anyone involved in reef 
education, monitoring, or management, in addition to those who live and 
recreate in reef ecosystems. ReefBase is the official database of the 
Global Coral Reef Monitoring Network (GCRMN), as well as the 
International Coral Reef Action Network (ICRAN). Ultimately the main 
goal of ReefBase is to "facilitate sustainable management of coral reefs 
and related coastal/marine environments, in order to benefit poor 
people in developing countries whose livelihoods depend on these 
natural resources," (www.reefbase.org). 

Research Activity - What Threatens Our Reefs? 

1. Open your internet browser navigate to one of the following news 
web sites ... 

CI) CNN Ne\J\IS - www.cnn.com/ 

CI) BBC NeVIIS - neVIIS.bbc.co.uk/ 

CI) ABC Ne\J\IS - abcneV11S.go.com/ 

CI) Fox Ne\J\IS - www.foxneV11S.com/ 

CI) CBS Ne\J\IS - www.cbsneV11S.com/ 

CI) Environmental Ne\J\IS Network - www.enn.com/ 

CI) Environmental Ne\J\IS Service - www.ens-neV11S.com/ 

CI) Planet Ark- http://www.planetark.com/ 

CI) MSNBC Environmental Ne\J\IS - http://www.msnbc.msn.com/id/3032493/ 

CI) National Geogrpahic Ne\J\IS - http://news.nationalgeographic.com/index.html 

2. Find articles written within the last year about coral reefs. Find and 
read at least five articles from different web pages. 

3. Take turns sharing what you have found with your classmates. 

4. Search again but for articles discussing the threats to coral reefs. 

/ After sharing again with your classmates compile a list of threats to 
coral reef ecosystems. 



R,e,fr,esh map 

1@1 Zoom In 

Exploration Activity - Researching Your Reefs 

1. Open your internet browser and navigate to www.reefbase.org. At the 
top of the page click on "Online GIS." 
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2. The screen that opens is an online version of a GIS. The Table of 
Contents on the le'ft displays layers of data that are available. The 
ones with a checkmark are the visible layers. In order to get the map 
to change when you click the different boxes you will have to click the 
Refresh Map button. 

3. The first map that is displayed shows the locations of all of the coral 
reefs in the world. 

/ Discuss with your classmates where the reefs are located and what 
factors limit their distribution. List your ideas below. 

Your assignemnt on this webpage is to collect maps, photos, and 
information about a specific reef to report on . To begin you must select a 
country. 

4. You have two options to select the country that you wish to research. 
You can either use the Zoom In tool to locate your reef or you can use 
the dropdown menu at the top of the page. 



5. When you have selected your country zoom in and center it on your 
map. Turn on only the Coral Reefs, Countries, and Bathymetry and 
refresh your map. 

6. Click the Save button from the right. ~ Save 
Select your image size and click Submit. Right-click 
to save the image according to your teacher's instructions. 

7. Repeat these procedures to create maps of your reef that show 
spawning sites, bleaching sites, coral diseases, monitoring site, and 
protected areas. If your country does not have any one of these there 
is no need to create a map for that data layer. 

8. If there are occurrences of any of these you may learn more 
information about them by clicking the Query Features button, 
clicking the Radio button to the right of the layer name in the Table of 
Contents and then clicking the feature on the map. 

r ., Col'al SpawninQ 

I .. Coral Bleaching r 

:1] Query Features 
r * Coral C,,i;$~-aiii.;:s r 

r 0 Monitoring Sif;e.s r-

r ICRAN Sit~s r 
,-

© Protected .AJ@3S r I 

r Mangroves 

The next step will be in information and photo gathering. While this 
lesson only describes how to locate data from this web page, do not 
limit yourself to only searching ReefBase. Your teacher will tell you how 
many sources are required. 

9. Close the Online GIS window. From the main ReefBase webpage 
click Resources from the menu on the left. Once in the Resources 
page click Resources: Overview and select your country from the 
dropdown list. Not only will this page provide you with some 
background information on your country and its reefs but you will 
also know what other information is available. In the list on the left 
the fields that are grayed out do not have any information available. 
If your country has very limited information you may have to try to 
find it from another site or select another country. 

10. Gather as much information on your country and your reefs as you 
can. At this point you may want to start building your PowerPoint, 
paper, poster or other project. Select the type of project that you feel 
most comfortable working on! 

11. Try to find information as outlined on the ReefBase website, the 
resources available, the status, the threats, and the management. 
When using other web pages be cautious of the quality of the 
content. ReefBase is a peer review product of scientific research not 
all other web pages can make that claim! 
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12. Select Photo Gallery from the menu on the left. If you had already 
been searching for information on your county's reefs, images from 
that country will automatically open. 

**Unfortunately if you wish to download full-size images from ReefBase 
you must register as a user. Simply fill in the registration form to 
gain access. If working on this from school use your teacher's 
email address. You will need an access code that they email you 
to activate your account. If you send it to your email you may not 
be able to access it from school. 

13. When you have all of your information build your project to educate 
your classmates, other students from your school, or your members 
of your community. 

/ As a class discuss some of the threats to different reef ecosystems 
from around the world. Discuss the efforts currently made by 
scientists to monitor, protect and preserve reef ecosystems. List 
some of the ideas below. 

/ Write a one page plan of action for your country to protect their reef 
ecosystems while meeting everyone's needs. 

/ As a class discuss the ways that you impact reefs all of the way from 
your community without even visiting them. List those below. 



Web Links: 

~ The Coral Reef Alliance 
http.1/www.coralreefalliance.org/ 

~ CRC Reef Research Centre 
http:llwww.coralreefalliance.org/ 

~ NOAA's Coral Reef 
http:llwww.coralreef.noaa.gov/ 

~ ReefBase 
http://www.reefbase.org/ 

~ Reef Check 
http.1/www.coralreefalliance.org/ 

~ SeaWorld Coral and Coral Reefs 
http:llwww.seaworld.orglanimal-infolinfo-books/corall 

~ United States Coral Reef Task Force 
http:l/www.coralreefalliance.org/ 

Portfolio Planner: 

Compile the following in portfolio format. .. 

~ Full Page Copies Of Maps And Photos You Have Collected 

~ A Copy Of Your Poster, PowerPoint, Etc. 

~ A Copy Of Your Reef Action Plan For Your Country 

~ A Self-Evaluation - Protecting Reefs Rubric 

References: 

ReefBase: 

Oliver, J., M. Noordeloos, Yusuf, Y., M. Tan, N. Nayan, C. Foo, and F. 
Shahriyah [No Date]. ReefBase: A Global Information System on Coral Reefs 
[Online]. Available: http://www.reefbase.org [Accessed: 8 July, 2004] 



Protecting Reef Presentation Rubric 

(Excellent) (Very Good) (Good) (Needs Improvement) (Poor) 
(5) (4) (3) (2) (1) 

Explains what 
Some information 

Fails to_explain 

Reef Resources 
kind and how missing or what kind and 
many reefs how many reefs 
there are. 

inadequate 
there are 

Describes how Some information 
Fails to describe 

Reef Status these resources missing or how these 

are doing. inadequate resources are 
doing. 

Identifies which Fails to identify 
negative Some information which negative 

Reef Threats influences are missing or influences are 
impacting coral inadequate impacting coral 

reefs. reefs. 

l=xplains what is, 
Fails to explain 

or could be done Some information what is, or could 
be done to 

Reef Management to monitor and missing or 
monitor and 

manage these inadequate 
manage these resources. 

resources. 

Concise & Clear & 
Average, 

Creative organized 
organization Disorganization; Chaotic; detracts 

needs leads to errors in ~rom presentation 
presentation presentation improvement communication 

Writing Style & Format 
Format High Quality re. Minor errors in Minor errors in Major Errors in both guidelines not format, format and both format and format and grammar/ met, major 

grammar, and grammar/ grammar/ Spelling language errors spelling spelling Spelling 

Excellent, 
Complete, good 

Scientific Content 
Creative, 

material, 
Average Incomplete or Substantially 

Accurate, 
accurate 

coverage inaccurate incomplete 
Complete 

Literature & Photo 
Multiple Poor Quality but 

Poor Quality and Only one reference / Incomplete or 
Citations 

References Enough Few References major errors plagiarism 
present References 

Peer Rating (Avg.) (5) (4) (3) (2) (1) 

Column Subtotals: 

TOTAL= 

~ 1r· ~ - ... """"- .. -"·· .,~ ........... ,. .. , . i=i..,_ ·-•·· •• ,.,,r .... 



Tracking Sea Turtles 
Dive into the life of a sea turtle. Follow the path of sea 

turtles as they journey across the ocean. 



fucbing$ta Turtles
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Overyiew:

Where have you been today? lf this is a typical school day you
probably began your day at home, made your way to school, and will
head home or to work after school. We tend to fall into a routine. On
weekends or during the summer our pattern changes and we may
venture out farther to bigger cities or on a vacation. Animals are much
the same they have their daily routines, but every now and then they
journey out a bit farther. Wildlife biologists often track the movements
of animals to learn more about them. ln this exercise you will use GIS
to track the movemenb of sea turtles as they venture off into the open
ocean.

Materials:
. Computers M internet arcess
. ArcMew GIS
o GIS Data
. Color Printer
o Copies of this Lesson
. Copies of the Rubric

m Vocabulary

Global Positioninq Systenl -
24 satellites used to determine
location on the eafth's surface

Background:

The easiest way to understand wildlife is to spend time observing
them or what they leave behind. Unfortunately, not many wildlife
biologists are welcomingly accepted into wildlife societies. So biologists
try to follow an animal's movements to better understand what they do.
Tracking an animal can be as low-tech as following a set of track in the
snow or as high tech as using Global Positioning System transmitters
and following an animal from your computer.

/ As a class discuss some of the reasons why scientists might
track wildlife. List them below.



Application Activitv - Trackins Sea Turtles

Following animals on land is one thing, butwhat about across the
open ocean. Scientist know very little about life in the open ocean.
Studying it presenb obvious challenges. For sea turtles the females
are the only ones e\ter seen on shore and that is when they are nesting.
Once hatched the hatchlings that survive predation and other risks on
land disappear into the seas. Most males will never be seen again and
the females will not return until they are sexually mature.

Tracking sea turtles is only possible with satellite transmitters.
These transmitters work very similar to the Global Positioning System
that you might use on a camping trip. The location of the turtle is

calculated by satellites and instead of sending the information back to
the turtle, it is sent to the researcher. In this activity you will take actual
data from turfles tracked all over the word, plot it on a map, and create a
turtle journal speculating what the turtle was up to on its journey.

1. Open ArcView. If prompted to create a new proiect or open an
existing project choose to open an existing proiect. lf you are not
prompted, click the File menu and choose Open Proiect.

2. Navigate to the Understanding Our Environment with GIS directory
(See your instructor for the path), open the Tracking Wildlife folder
open the Turtle Tracking.apr file.

3, Click the Tables icon in the Turtle Tracking proiect window. Click
Add. Navigate to the Understanding Our Environment with GE
directory open the Tracking Wldlite folder, open the Turtle Data
fotder. Hold Down shift click and drag down the entire file list to
selecf all files, Click OK

Each of these windows is a database file of latitude and longitude
locations of actual turtles that were tracked by scientists. Each file was
created in Microsoft Excel and saved as a .dbf file. Additional locational
data can always be added to ArcView in this same fashion. Simply type
in the latitude and longilude of the data points that you would like to add
and sarc them as <filename>.dbf.

4. IJnder theWindow menu click Turtle Tracking.apr to bring the proiect
window to the front. Click the Wews icon. Doubleclick the Tracking
Turtl* Wew to open it. You should see a map of the wodd with a
Table of Contents on the right.

Selecf Add EventTheme from theWew menu. ln theTable dropdown
menu selecf the name of one of the turtles that you would like to
track. Click OK Notice that the turtle's name was added to the Table
of Contents. Repeaf that process for four other turtles.

To rewrite the turtle name with out the .dbf after their name, click the
name of the turtle that you would like to change. Selecf Properties
from the Theme menu and erasethe dbf from behind their name.
Click OKwhen you are finished. Repeat this for all fwe of your
turtles.

m Vocabulary

Proiect - An ArcView file that
organizes your data & prducfs

Theme - A set of related
geographic features in point line
or polygon format

Mew - The map area and a table
of confenfs of available data
layers

5.
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7. To change the color of the dot representing the turtle, double-click
the turtle's name in the Table of contents. This opens the Legend
Editor. Double click the Symbol box with the dot in it. This now
opens the marker palette. Here you can change the shape of the dot"
Do so if you wish. Then click the Color Palette tool to select the
color. Rememberto selectsomething that shows up against the blue
ocean. When you are finished close the palette window, click apply
and then close the Legend Editor. Repeat fhls process for all five
turtles.

? tist the names of the turtles that you have selected in the table later
in this lesson.

We will now locate and study each turtle's movemenb.

8. Turn on one turtle's locations by placing a checkmark in the box in
front of iE name in the Table of Contents. You may see some dots
appear on the map.

To zoom in, click this turtle's name once to make it active. Click the
Zoom to Active Theme(s) button. This should zoom and center all of
th at tu rtle's location s.

In the table, fill in the number of locations and if there are any
obvious data errors. To avoid having to count all of the dots, select
your turtle's name from the Window menu. At the top of the table it
will tell you the total number of locations.

71 selecled

/ ftn in the table later in this lesson with the name of the country or
countries near this turtle's locations. (lf you are not certain what
countries they are, make the countries theme active and use the
ldentify tool.)

We will now try to piece together details of one of the turtle's journeys .

? From the data table for your turtle determine how long the turtle

I was tracked. The date in the first column is in Year-Month-Day
r format. Forexample: 19991120 is November20, 1999.

t, 
10. Click the first entry in the data tabte to highlight it. Minimize the
data table. You should now see one of the dots highlighted on your
map. That point is the first location for that turtle.

Il.We will now add date labels to connect the dofs.. From the
Theme menu choose Clear Selected Features. Again from the
Theme menu select Auto Label. Selecf Date from the Field
dropdown menu and click OK

12. Go back to that first location, Selecf the Draw Line Tool (lf it 'B

not available hold down the last button in the second row of icons
until it appearn. Now connect the dots,! Use the Zoom In or Out

tools to help locate the next dot.

f oK | f,ancer 
I

El Draw Line
H zoomln H zoom out



13. When you are finished double click to end your line. Click the Pointq
tool and double-click your line to open the Pen Palette. Scroll down
andselecf a line with arrows.

14. Turn off the labels by selecting Remove Labels from the Them menu-

15. Be certain that the them that you have been working on is sfiTl active
in the Table of Contents. Click Zoom to Active Theme(s) to recentq
it. When you are safisfied with the way your map looks choose
Layoutfrom theWew menu. Click Landscape and OK'

The layout will be created automatically for you. lf necessary maximize
the size of your Layout window.

16. Maximize the window. Double-click thetitle of the map and change it
to "<Turtle's lVame> Satellite Tracking."

21. Click the Text button. Position the cursor below the North Arrow and
click once. Type in your Name and date in the Text Properfies
window and click OK.

22. Finally from the Layout menu cfioose Properties. Rename it
" <T u rtle's N ame> Safellite T racki n 9."

23. tf you would like to print, from the file menu, click Print. Click Setup
to change your print settrngs orselect a printer. (Be sure landscape
is checked and printto a color printer if one is available.) Click OKto
send the layout to the Printer.

24. Saveyour Proiect by clicking Save Proiectfrom the File menu.

,/ Select one of your turtles and write a travel journal for it. Write an

entry for each date and date point.

Web Links:

Caribbean Conservation Corporation
h ttp : //v,rww. c c ctu rtl e. o rg /c cctn p. h tm

Field Trip Earth: Trackinq Wildlife with AerialTelemetry
www.fieldtri pea rth.oryla rticle.xm I? id=7 1 5&o rd i nal= 1

Journev North
rrwrw. le a rn e r. o rg[ n orth/

ArcNevra - GIS Helps Reduce IncidentalSea Turtle Caoture
www. e s ri. co m /n ews/arcn ews/wi nte rO 30 4 afti cl es/i n - b nz i L htm I

The Use of Geoqraphic Information Svstems (GlS) in Marine Turtle Reqegrch
www.bt i o. d av id s n. e d u/pe opl e/m id o rc aVGlSc/asVG/SuebsifeMazT/s on/wi I I so n. htm

Portfolio Plapner:

Compile the following in portfolio format...

C Layouts Displaying The Paths Of The Turtles That You Tracked

O A Copy of Your Data Table

C A Copy Of Your Turtle Travel Journal

e A Self-Evaluation - Turtle Tracking Skill Rubric

rCi Pen Palette

ru#:

I *-t'-
Li ../ -r

lrr,.;...j 
r'" *

"rq*.f ffj
, 5iEe:

, faF:

Jnin:

E rext

m Vocabulary

Layout - An arnngement of map .

elements for printout or digital
display
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m References

Trackino Data:
Seaturtle.org (No Date). Satellite
Tracking Data. [Online] Available:
http: //www. s eatu rtle . o rg/tracki ng/
teachers/data.shtml. [Accessed
on June 29,20041.





Tracking Turtles Sk//s Rubric

SKiII Excellent Good Needs lmprovement

Listening & Hypothesizi ng
(Class discussion)

(pg. 23)

I listened and did not criticize
the opinions of my classmates
and I shared a few of my own.

I only shared one opinion , but I

listened to the other students.
I wasn't listening to the others
and I didn't share anything.

Adding & editing turtle
data on a base map

(pg .24 & 2s)

I kept up with the instructions,
plotted all of the turtle data, and

changed the point colons to
make my rnap more visually

appealing.

I had a hard time adding the
data or changing colors, but I

got it done.

I could not add the data or
change the colors without the

help of others.

Exploring data
(pg ,25)

I was able to work with the data
both in the table and on the

map to answer the questions.

I was able to work with the data
in one location, but not the

other, but with help I completed
the table.

I could not answer many of the
questions in the table because I

could not work with the data in

the table or on the map.

Scrutinizing Data
(p9. 25)

I was able to tell immediately
wlrich data points were not

correct.

It took me awhile, but I figured
out which data points were

inconecL

I could not figure out which data
points were not mrrect"

Creating a layout
(pg. 26)

The layout was done even
before you assigred it!

I followed the directions and
completed the layout as

assigned.

I could not follow the directiors
or did not complete the layout.

Hypothesizing & creative
uniting (Journal writing)

(pg. 26)

My journal contained entries for
all of the data points. I used my
knowledge about sea turtles to
hypothesize what it was doing.

My journal was missing some
entries, but I hypothesize what

the turtle was up to.

My journal was missing a lot of
the entries and my hypotheses
were not relevant to sea turtles.



Estimatit ervious $"r{"ces
Analyze the severity of urbanization in your community

hy estimating the amount of imperuious surfaces.
Recom me nd altern afives for d evelo pm ent.



Materials:
. Computers wl internet access
. ArcView GIS
o Color Printer
. Copies of this Lesson
o Copies of the Rubric

ru Vocabulary

lmpervious Surface - AnY surface
which does no allaw water to
soak in

Nonpoint Source, Pollution -
Pollution that comes fram a
variety of soutces that are not
directly identifiable

Lstimating l*pervious

Surfaces
oftain is a b/."sing *1r", ft fa/lsgent/g

on p"r.lr.d {i./d", iurning the eaft/t green,
caunng the b;rd" to sing."

DorrlJ lftorster, "fvfeeting tfr" f*pectatioru o{t/r. l-unJ", I9s+

Overview:

What happens to the rain falling on your
roof? lt most likely slides down some shingles into
an eves trough and out the downspout. lt is

amazing how much water pours out that downspout
when the raindrops are so small. lf that much
water is collected just by your roof, imagine how
much rain must be collected by the parking lot at
your school! Unfortunately this water that runs off
some other surface before infiltrating the ground is

more likely to pick up some form of pollution. During heavy rains or
snow melts impeMous surfaces also increase the risk of flooding. In

this exercise you will begin to estimate the amount of these surfaces in

your community and make recommendations to improve regions that
posse the greatest risk.

Background:

Every drop of rain driven by the forces of gravity is seeking ib
way to the ocean. The path they take is often based on pure luck. The
obstacles they meet may be creations of nature or man. Nature took
the rain into consideration and left small spaces in the soil. Humans on

the other hand have intentionally desired the rain to run off. After allwe
wouldn't want the rain to soak into our roofs. The dirt roads of
yesterday were great until it rained and they became impassable. As
our urban areas continue to sprawl across the countryside, the amount
of land area that rain cannot penetrate is increasing.

Surfaces that rain cannot penetrate are referred to as

impervious surfaces (lS). Pollutants can accumulate on these
surfaces from various Sources and be washed into our groundwater or

lakes and streams. This type of pollution is called nonpoint source
water pollution. The exact source of the pollutant usually cannot be
identified.

? Wnat types of pollutants might you expect to find on impervious

surfaces such as roads, parking lots, and buildings?



Skills Activitv - Downloadinq Aerial Photoqraphs for GIS Use

Aerial photographs or orthophotographs are images taken from
either an air plane or satellite in orbit. Either one can be a very useful
data source for GIS work. Unlike feature data, the interpretation of what
is on landscape is left up to the viewer. Yet features such as roads,
water, buildings, land use and vegetation can all be seen using them.

Obtaining and using orthophotographs can be a challenge. This
first activity is to ease that challenge so that we can get on with looking
for those impervious surfaces. Many of the instructions in this section
have been taken from a USGS web page written by Dr. Joseph Kerski.

ng Vocabulary

Orthophotooraphs - Photos taken
from an aeial view in which the
distortions of topography and
camen angel have been
removed

7. Open your internet browser and navigate to the
Terraserver webpage at http:l/terraseruer-usa.
com/.

2. Type in a specific city (without a sfafe name)
and click Go.

3. Selecf the correct citylstate combination that
you are interesfed in from the list that appears.

4. Select an AERIAL PHOTO of the area you are
interested in. Continue zooming and panning
using the compass rose and the plus and
minus srgn below the compass rose until your
desired area is in the view. Make the image
size LARGE using the button below the zoom
bar. To get the mosf detail possib Ie zoom the
image to I meterresolution.

5. To download, do not right click on the image at this point, or you will
only obtain a very small portion of the image. Rather, selecf
DOWNLOAD on the button bar above the image the photo.

-:: ::.:. :: -r-.
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6. After the image fias redrawfr, right-click on the
image and SAVE PICTUREAS
<filename_doq>jpg For example,
oakcliff_doqjpg. lf you will need to download
multiple phofos name them
<filename0l _doq>jpg accordingly.

The image alone is not enough to use in
ArcView. You must also download something
called a World File that registers the image to a
specific location. This location makes sure that
everything lines up when additional data is
included.



8. Ctick on the WORLD FILE link to open the registration file for the
image in the browser window. When that window opens click Save
As irom the File menu. Change the file type to TAff. Save the file *
<filename>jgw. Be sure to save fhis as a type Ttrf file, not HTML,
hut keep thC extension of the file JGW, not TXT. AIso, it must have
the same base name et$ your JPG file, above. For example,
oakcliff 

-docligw.
Open ArcView. lf prompted to create a new proiect or open an
existing project cfioose to create a new proiect with a new view. If
you are not prompted, click the File menu and choose New Proiecl
ln the File menu selecf Extensians. Turn on the JPG reader
extension.

10, CIicR the Add Theme button and navigate to the directory where you
saved your images. Change the Data Source Type to lmage Dgtg
Source and select the images you wish to open. To open multiple
files at once hold down the Shift key.

ll.Turn the images on by clicking the small box next to their names in
the Table of Contents. If they do not appear, be sure to check your
file names on your system.

Problems?

Problems with the image not regisbring are almost always a Windows,
not a GIS problem, and most likely because:

1. Windows has saved the world file as HTML. Access Wordpad and
save the file as .txt, removing all HTML code.

2. Windours has saved the header file as filenamejgw.txt, for example,
oakcliff-doq.jgw.txt. Rename the file and remove the .bd

extension. lf you cannot see the .txt extension, in Windows
Explorer, first view the file lisF as "Details". Then go to Tools->
Folder Options, and View (for Windows 2000, other operating
systems have the folder options in a slightly different place) to
UNCHECK - Hide file extensions for known file types.

To get multiple downloaded files to line up seamlessly pan twice to the
east or west in Terraserver and once to the north & south and then
download another image. There will be some overlap on the north and
south move but is will be unnoticeable.

Application Activitv - Diqitizinq lmpeMous Surfaces

With your images loaded into ArcView you are now ready to
begin recording a surface's impeMousness. For this exercise we will
start by digitizing the impervious surfaces around the school. We will
create new themes for each type of impervious surface. Finally we will
estimate the percentage of land that is impervious in a given area.

9.

E Add rheme

{ ShanuannCI1-D ilD.ipg

m Vocabulary

Registration file - A file that align
two or more maps or images so
th at eq uivale nt g eog n Ph ic
coordinafes coincide.

Proiect - An ArcView file that
organizes your data & Products

Ihene - A set of related
geagraphic features in Point line
or polygon format

Mew - The map area and a table
of contents of available data
Iayers

Diqitizinq - The process of
obseruing a feature on an image
and outlining its peimeter to
convert it to a feature.



5,

7,

2.

3.

L

9.

With your orthophotographs turned on use the Zoom In tool to focus
on your school. While we will eventually digitize the entire school
property, zoom ln so that your school takes up the majority of the
view.

From the View menu selecf New Theme. Select Polygon as your
feature type and click OK Name the file buildings.shp and save ff
according to your teacher's instructions.

Notice that the buildings.shp theme is added to the top of your Table
of Contents and it has a dashed line around the checkmark hox. This
means thatthis theme is in edit mode and can be altered.

4. To rename this theme select properfies from the Theme menu . ln the
Theme Name box delete the file extension .shp.

To change the theme color and pattern open the Legend Editor by
double-clicking the theme name in the Table of Contents. Doubl*
click the Symbol Box. Select one of the hatched patterns by clicking
once. Click the Color Palette tool to selecf a eolor for the hatch
marks. Selecf red and then click the dropdown menu. Selecf
Background and click the box that is x'ed out. Selecf Outline from
the dropdown menu and click the same color red. Close the Color
Palette window, click Apply in the Legend Editor and close that
window as well,

Making your way around the building click on every corner. Double
click to finish the polygon. If you accidentally double click early or
click in the wrong spot you can use the Vertex Editor to move or add
points.

7. Digitize all of the buildings on your school property. When you are
finished select Stop Editing from the Theme menu. Click Yes fo save
your edits.

Create themes for the parking lofs, sidewalks, driveways, trails or
recreational areas (1.e. paved playgrounds), and outdoor pools or
patios. Rename & recolor fhose themes using the same process €ts
you used for the Buildings.

Add one more theme for the entire school property. Make this theme
just an outline.

10. Click the theme name of your school property theme once to make
sure that it is the active theme. Click the Open Theme Table button.
Here we will calculate the area of the scltool grounds.

fr 5i*to Definition 7 7. Maximize the window and serecf

H Zoom ln

fr ritt Paterte

sldlP IA%la l@

Dutline: re

Color Palette

Polygon
6.

f Vertex Editor

trl Open Theme Table

Nama: lTiil-- | 0K -1, ltarf Editing from the Table menu.
L.-..LJ ', From the Edit menu selecf Add Field.

ln the N ame hox type "Area."
Change the number of Decimal
Places fo "2," Click OK.

Type:m

Width: l-Tf
Decimal Flaces: f-----T

I
ffi
ffi

ffiWil

ffi
f,''El
[' :':;:':':l
L.j-.-L-:--.:*:l

m
F-l
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Flequests

H Calculate 12. Click the Area column heading and click the Calculate button to open
the field calculator. In the [Areal = box type "[Shape].RetumArea"

(AII capitalization and punctuation musf be exact.)

Type

tT Number

t^ Sking

(- Date

7 2. The number placed in the Area column is the
area of the school property in square meters.
Select stop editing from the Table menu and save
your edits.

7 3. Repeat fhese procedures for each of the other
themes that you created for your school. When
there are multiple features in a theme you will have
to add them to get the total area.

74. When you are finished save your work
according to your teacher's instructions.

I rLl
f,ancel 

I

/ fm in the following tahte with the results that you receive and
calculate the % for each imperuious surface. If the surtace was not
present use enter zero.

/ n 40:60 ratio of developed to undeveloped is a maximum
recommended ratio for urban areas. Does your school fall in this
range?

/ When it rains hard does your school have a runoff problem? lf so
describe what happens.

? lf your school has a retention pond for runoff, research and design a

rain garden to propose to your principal or school board.

lArea] =

[5hape].HeturnA,rea

Total Arca % of Total

Buildings

Parking Lots

Sidewalks

Driveways

Recreational Areas

Pools/Patios

Entire Property

lmpervious Surface alo



Community Action

Armed with your new skills and knowledge, set out to analyze the
imperviousness of your entire community. Assign neighborhoods to
different groups of your classmates. lf possible try to complete the
analysis within the boundaries of watersheds. lf yourwatershed is less
than 10% impervious it is well protected from impact. Between 10 and
25o/o it is at risk. Above 25o/o imperviousness and your watershed is
likely to see degradation to the streams, lakes and groundwater.

/ Research alternatives to impervious surfaces. List some ideas below.

Take Action

@ Educate your community about impervious surfaces by creating posters,
giving community presentations or writing articles for the newspaper!

What you can do to prcvent Urban Stormrmater Runoff

. Keep litter, pet wastes, leaves, and debris out of street
gutters and storm drains--these outlets drain directly to lake,
streams, rivers, and wetlands.

Apply lawn and garden chemicals sparingly and according to directions.

Dispose of used oil, antifreeze, paints, and other household chemicals properly,
not in storm sewers or drains. lf your community does not already have a program
for collecting household hazardous wastes, ask your local government to establish
one.

Clean up spilled brake fluid, oil, grease, and antifreeze. Do not hose them into the
street where they can eventually reach local streams and lakes.

Control soil erosion on your property by planting ground cover and stabilizing
erosion-prone areas.

Encourage local government officials to develop construction erosion/sediment
control ordinances in your community.

Have your septic system inspected and pumped, at a minimum, every 3-5 years
so that it operates properly.

Purchase household detergents and cleaners that are low in phosphorous to
reduce the amount of nutrients discharged into our lakes, streams and coastal
watens.



e

Web,Links:

C Inpervious Surfacps - Land lnformation Acgess AsgoqiAtign

http //www. I i a a. o rg/pl a n n i n ged uc 0A M . a sp

C Polluted Runoff (Nonpoint Source Pollutign)
h ttp ://www. e p a . g ov /owowln P sl

Portfolio Planner:

Compile the folloraring in portfolio format...

@ A Printed ffiqe Af Your Community Tal<en From Tenaseruer

@ A Layout Of The hrpervious Surfaces At your School

6 A Copy Of YourDataTable showing lmperuiousness of Yourschool

$ Layouts Of Any Additional Impervious AnalysisYou Conduct

O Gopies Of Posters, Presentations, And Other Educational Materiab
You Developed

o A Self-Evaluation - Mryping Imperuious surfaces skitts Rubric

h ttp : //www. d n r. st ate . w i . tt s/o rg /W ate rlw m /n p s/

References:

Runoff lmage:

Fort Collins Utilities (2004). City of Fort Collins Stormraater Quality. [Online]
Available: http://www.fcgov.cony'stormwater/stormwater-quality.php.

USGS Diqita I Orthophotos:
USCS. (ZbO+). Terrreerver-USA lmage Database. lOnlinel Avaliable:
lrttp ://terraserver. microsoft. com/

lnstructions for usino Terraserver:
Kerksi, JJ (2OOS). Downloading and Formatting Earth lmages (Topographic
Maps and Aerial Photographs) from Terraserverfor Recrcational, Scientific,
Educational, and GIS Use. [Online] Available: http://rockyvueb.cr.usgs.gov/
pu blic/o utreacMerraserver.html



Mapping lmperuious Surfaces S-Kr/ls Rubric

skill Excellent Good Needs lmprovement

Listening & Hypothesizing
(ldentifying po llutio n

types)
(pg. 31 )

I listened and did not criticize
the opinions of my classmates
and I shared a few of my own.

I only shared one opinion , but I

listened to the other students.
I wasn't listening to the others

and I didn't share anything.

Utilizing and online GIS
(pg. 32)

I was able to navigate right to
my community on Terraserver
and obtain the images that I

wanted.

After I received a little help, I

was able to find what I needed
from Terraserver.

l'm still lost! | was not able to
find what I needed on

Terraserver.

Organize and manage
files

(pg. 32)

I was able to download the
images and world files for my

community and $ave them with
the correct extensions.

I was able to download the files
but I had trouble with the file

extensions.

I don't remember where I saved
anything or what I called it.

Register an image
(pg. 32 & 33)

I correctly saved the world file
and it opened perfectly in

ArcView.

I didn't get the world file saved
correctly the first time, but I

corrected the mistake and it
worked fine

I needed assistance to get the
world file saved and opened

correctly.

Displaying an image
theme as a base map

(pg. 33)

I knew how to use the
extensions and open an image

file.

I had a hard time opening the
image at first.

I could not open the image file.

Interpret aerial photos &
Discriminate i mpervio us

from pervious
(p9.34)

I could easily tell what was
impervious and what was not.

After someone showed me
what was impervious, I was

able to tell.

I cannot discriminate
impervious from pervious.

Creating new themes and
digitizing from a base

map
(ps- 34)

I was able to create themes and
digitize all of the data without

any assistance.

After receiving help, I was able
to create new themes and

digitize.

I am not able to create new
themes and digitize data.

Editing attribute data
(pg. 34 & 35)

I easily edited by attribute
tables to calculate the area for

each new theme.

With help I was able to edit my
attribute tables and calculate

area for the new themes.

I was not able to edit the
attribute table or calculate area.

Evaluating data & making
recommendations

(pg. 35 & 36)

I could clearly see that our
school either did or did not have

a problem. I made several
recommendation to improve the

imperviousness.

I had a hard time seeing the
problern and I only had a few

recom mendations.

I did not evaluate the data and
made no recommendations.

Community Action
(pg. 35 & 36)

I participated in estimating the
imperviousness for our

community and I helped create
or deliver presentations.

I participated in only one of the
activities.

I did not participate in either
activity.



MonitoringA Wterslted
Esfablish a water quality monitoring program in
your watershed. Analyze the impact of different

land uses on water quality and educate your
community on water qualitY issues.



M o n rto n ng A l/l/" te rs /t. d

"/ iver is t/te report."rd {or its waters/teJ."

Overview:

Measuring water quality only once is like a single snapshot in time.
lgnoring the past and the future, you would see what the water was like
at that moment. While you may be able to tell that it is polluted, you
might not make the connections between water quality and the changing
face of the landscape across the watershed. Monitoring a watershed is
an ongoing activity that allows one to continuously observe changes and
establish cause and effect relationships. The use of GIS in this exercise
provides opportunities for data storage, query, and analysis. While this
lesson will not provide specific details of water testing, it should serve as
a guideline to helping you set up a monitoring program in your area.

Background:

$ What is a watershed?

To answer this question we really have to back up all of the way to
understanding the water cycle. Where does our rain come from and
where does it go?

? On your own or with your teacher's help fill in the boxes below with
the correct terms...

,4
*-------*.* 

*-----nt-

ateria ls:
Water Test Kits
Probes or Meters
Waders
Computers wl internet access
ArcMew GIS
GIS Data
Microsoft PowerPoint
Color Printer
Copies of this Lesson
Copies of the Rubric

Ee Vocabulary

Condensation - To change from a
gas to a liquid

Evaporation - To change from a
liquid to a gas

Precipitation - Any form of rain,
snow, sleet, etc.

Root Uptake - Plant absorbing
water into their roots

Rungff - Water moving across the
landscape, not soaking into the
ground

Seepaoe - Water soaking into the
ground

Transpiration - Evaporation of
vnter from the learles of plants



Rain falling to the ground really has two choices, it either seeps
into the ground becoming part of the groundwater, or it runs off of the
land into ditches, streams or rivers. Even water that soaks into the
ground is pulled by the force of gravity toward areas of lower elevation,
many times that means it is headed to a river or lake. Every piece of
dry earth is sitting in what is called a watershed. A watershed is the
area of land that catches precipitation that will always drain to a
particular body of water, whether through the ground water or on the
surface in rivers. The boundaries of watersheds are determined by
elevation.

m Vocabulary

Watershed - The arca of land that
drains into a common body of
water.
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Watersheds are usually named
after the body of water that the
precipitation will enter into. Since
all streams and creeks continually
merge until flowing as a large
river, watershed can be thought of
as a set of nested eggs, one fitting
into the other. Let's start large
and work our way in. All of the
water that falls on North America
actually has five choices: 1) the
Arctic Ocean, 2) Hudson Bay, 3)
the Pacific Ocean, 4) the Atlantic
Ocean, or 5) the Gulf of Mexico.

/ Which way is the rain from your class going?

When we zoom in we find that within a watershed there are many
other smaller watersheds. Each stream or tributary has its own
watershed. Each of those watersheds may have even smaller
watersheds within them.



ru Vocabulary

Proiect - An ArcView file that
organizes your data & products

Therne - A set of related
geographic features in point line
or polygon format

Mew - The map area and a table
of contents of available data
layers

. 
/,ft W*tcome to ArcViernr GIS

fr (- Open an existing proiect

17 Show this windsw when ArcView 615 starts

H Add rheme

Activities:

Research Activitv - Mappinq vourWatershed

Knowing information about your waterched will help you to
recognize important events that might have a big impact in your
community. We all depend on our watersheds in a variety of ways. Our
watersheds provide water for drinking, irrigation, industry, and recreation.
Ultimately the health of our environment and our economy are tied to the
health of our watershed.

Your first task is to locate and map yourwatershed.

7. Navigate your internet hrowser
Agency's Surt Your Watershed
wnfinfif .epa,gov/surtq

ls your watershed upstream
watersheds? lf so, which ones?

3.

to the Environmental Protection
website [http://

2. Click on "Lacate Your Watershed"

Use any method yau wish to locate
community is located.

the watershed where your

What is the name of your watershed?

How many counties are involved with this watershed?

Upstream:

or downstream from any other

Downstream:

Next we will build a few maps of your watershed that will help you later in
your monitoring efforts to store, analyze and display your findings.

Start ArcView. If prompted to create a new proiect or open an existing
project cfroose to create a new proiect with a new view. lf you are not
prompted, click the File menu and choose New Proiect.

Add data to your project by clicking Yes or the Add Theme Button.
Navigate to the Monitoring a Watershed data folder (either on the CD or
in a network drive, ask your instructor for verification). Open
wibasins.shp.

ii Directory: lgis\understanding out.envhonment\06 mnnitoring a watershed

-9* |
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6. Turn on the wibasins theme hy clicking the small box to the left of
wrbasins.shp. This will allow thattheme to be displayed in the view.

The first map that we will make is of all of the watersheds in the state,
highlighting our own.

7, We will first change the name of the theme from wibasins.shp fo
Basins. To do this open the Theme menu. Choose Properties. ln the
Theme Name box type Basins and click OKto return to theview.

'fi ffreme Froperties

Theme Name: |_ Use suffix

Sourcs 3 our environment\flE monitaring a watershed\wibasins.shp [PolyganJ

nK | [ancel 
I

Next, we will change the color of the Basins theme to something light,
so that we can highlight our own watershed.

8. Double-click on the Basins theme in the table of contents. In the
Legend Editor symbol box, double-click the colored box. ln the Fill
Palette, click on the paint brush. Selecf a lighter color. Close the
color palette. Click on Apply and close the Legend Editor.

9. ln the Edit menu, click Copy Theme. Then back in the Edit menu,
click on pasfe.

This will make two copies of the Basins theme. We will edit one of them
so that it only shows your watershed.

10. Click on the upper Basins theme in the table of contents to make it
active. Turn off the lower Basrns theme by removing the check from
the box in front of it in the table of contents.

We will now edit the theme for your watershed by deleting all of the
other watersheds in Wisconsin. To do this we will have to save our
changes. Ask your instructor about specific instructions for saving at
your school.

11.8e sure that the theme for your watershed rs sfitt active and select
Start Editing from the Theme menu. You will know thatyour theme is
in the edit mode when there is a dashed box around the checkmark.

l2.Click the Pointer button. ln the view, click and delete all of the other
watersheds but yours. Holding the Shift key down will allow you to
selecf multiple watersheds. lf you accidentally delete your
watershed, click Undo Feature Editfrom the Edit menu.

l,U ibss ins .s h F

r-1

Color Palette

.f],

Theme: lmGns

Legend TYPe: ffi'o, 
coror Palette

#llls lo%la l@

statistics-_l UnAo -J ,qppry 
I

f

Delinit

N

ifi w otf w aters he dr--'!f:]

, Basins

t:]

({r
ext Labels

H#
ieocoding

.qf
Editins

Cnmments:

-

I 

- 

t L

f,olor: ffi
Double click the sgq

f,ustom... 
I

E Pointer



13.7o save our edfts, go to the Theme menu and select Save Edifs As...
(save them according to your instructor's directions.) Then from the
Theme menu cftoose Stop Editing. (tf the theme that you edded is
not active make it active by clicking on it once in the table of
contents). When prompted fo save edits, click Yes.

*Note: If you did a Save Edits As..., then there are now 3 themes in the table
of contents. We nred to delete the one that is the unedited version of our
watershed. The edited vercion should end with .shp. To delete a theme,
make it active, and select Delete Theme from the Edit menu.

14. Rename the theme for your waterched by opening the Theme
Properties from the Theme menu and change the name of the theme
to the name of your watershed. Click OK to close the Theme
Properties.

15. Change the color of your watershed by doubl*clicking on the theme
for your watershed in the table of contents. In the Legend Editor
symbol hox, double-click the colored hox. ln the Fill Palette, click on
the paint brush. Selecf a color that contrasts the one you selecfed
forthe entire state. Ctose the color palette. Click on Apply and close
the Legend Editor.

16. Tum fhe Basins theme back on to view your map of your watershed
among the otherwatersheds of the state.

*Nofe: lf you cannot see your watershed you may have a problem in you table
of contents. Be sure that your watershed is located above fhe Basins theme.
lf it is not, click and drag it so that it is.

? Wny might this map showing the entire state be useful in a

presentation about our watershed?



At this time we are going to save our work and create a layout to display
our new map. Unlike working in a word processor where all of your
work is saved in one file, one ArcView project uses many different files.
All of them are accessed through a Project file. We will use one Project
file for the entire Watershed Monitoring Activity.

17. Start by changing the name of the view by clicking the View menu
and choose Properties. Change the Name box from Viewl to
Wisconsin Watersheds. While you are in the Wew Properties, type in
your name under the Creator, change the Map Units to meters and
the Distance Units to miles. Click OK

"Fi Vieuv Properties

Name: lWisconsinWatersheds

f,reation Date: lWednesday. July 07. ?004 ?:00:1? PM

lJonny ltlitchel,

Distance Units: lililes

Proiection,.. I Area Bf Interest... 
I

Backsround Eolor: fF<l sebct f,olor... 
I

18.In the Window menu selecf Untitledl. This should bring you back to
the Project Window. From the File menu cfioose Save Project As...,
call it Watershed Monitoring and save it where your instuctor direts
you.

We are now ready to create a display for our map to be used in printing
or in a presentation. ArcView calls a completed map with a title, scale,
and legend, a Layout. The layout will automatically include what is
displayed in our view. We must first be certain that what we wish to
display is centered and zoomed to the best possible scale.

19. Doubl*click on the Wisconsin Watershed view from the Watershd
Monitoring Project window. This will open our view window once
again. Be certain thatthe display shows the entire state of Wisconsin
filling the entire view. Also check to be certain that your watershed is
still displayed in a different color.

20. When you are safisfied with the way your map looks choose Layout
from the Wew menu. Click Landscape and OK

The layout will be created automatically for you. lf necessary maximize
the size of your Layout window.

f,reaton

m Vocabutary

Lavout - An arnngement of map .

elements for printout or digital
display

- lnl:J
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22. Finally from the Layout menu choose Properties. Rename it
Wisconsin Watersheds.

21.If you would like to print, from the file menu, click Print. Click Setup
to change your print setfings or select a printer. (Be sure landscape
is checked and print to a color printer if one is available.) Click OKto
send the layoutto the printer.

22. Save your Prgject again by clicking Save Proiect from the File menu.
lf you are finished for the day exit Arcwew, if not continue on the
nert exercise.

Review the Mapping Your Watenshed skills Rubric at the end of this
lesson the see how you did with your first watershed map.

Exploratorv Activitv - Gettino to Know YourWateshed.

The map that we have created does not really show us any details
about our watershed except for where it is located in the state and how
its size relates to the other watersheds in the state. In this next activity
you will be focusing your attention on developing maps within your
watershed. Each one will be useful to you when keeping tabs on the
health of your watershed

,/ Class Discussion: What type of information would be useful to knout

about your watershed? Write some of the responses below.



7.

2.

3.

Lakes & Rivers of Your Watershed

Open ArcVew. lf prompted to Create A New Project or Open An
Existing Project, selecf Open An Existing Project. lf not promptd
choose Open Project from the File menu. Navigate to the directory
where you saved your Watershed Mapping project file and open it.

lf either the Wisconsin Watersheds View or Layout is open, close
them. Clickthe Wews icon in the Projectwindow and then click New.
Maximize your new view.

Click the Add Theme button. Navigate to the directory where you
saved the theme for your watershed in the first exercise. (lncase you
forgot, you can open the Wisconsin Watersheds view, make the
theme for your watershed active by clicking it once and open the
Theme Properties window from the Theme menu.) Open this theme
and click OK

Click the Add Theme button again. Navigate to the Monitoring a
Watershed data folder (either on the CD or in a network drive, ask
your instructor forverification). Click on wilakes.shp , hold down the
Control key and click on wirivers.shp. Click OK to open these
themes.

{i\ Add rheme

Cancel 
I

tT Crhector,:*s

f^ ,-ihrariet

ldTx*tr,1tJ-*E;.' 
***3 fi*- -3

Faia Ssuir* Types:

6. Click and drag the themes in the Table of Contents so that
wilakes.shp is on top, wirivers.shp is nert, and yourwatershed theme
is on the bottom. Rename each of these, Lakes, Rivers, and the name
of your watershed, using the same procedure we used in the first
exercise to Lakes,. (Hint: Theme Properties).

7. Turn on all themes by placing a check in the box before the theme
name. Change the color of each by double clicking the theme name
to open the Legend Editor. Double-click the Symbol box to open the
Palette window. Click once on the Paintbrush to open the Color
Palette. Choose the same shade of blue for both the rives and the
lakes, and a lighter shade of another color for your watershed. Be
sure to click Apply each time and close both the Palette and Legend
Editor windows when finished.

Notice how long it takes to redraw your map each time to make a
change. This is because these are so many lake and rivers to draw
each time. We will speed up this process by eliminating all of the lakes
and rivers outside of our watershed. So you remember how we edited
all of the watersheds to only show our own? We will use similar
procedures to edit both the Rivers and Lakes themes.

ru Add rheme

5,

tr Color Palette

@
t/iews



8.

9.

We will edit the Rivers theme first. Tum off the Lakes theme by
removing the check in front of the theme name. Click the Riverc
theme name onceto make itthe active.

ln the Theme menu, click Select by Theme. In the first drop down
menu select Are Completely Within. Sef fhe second to read the name
of your watershed. Click New Sef. (Iltis process will take some time'
Arcwew may even seem to be locked-up. Wait and let it process the
command) When finished the rivers within your watershed should
be selecfed and highlighted yellow.

10. Select Convert to Shapefile from the Theme menu. Save fhls file in
the same directory you used earlier. Name it ABC Watershed Riverg
where ABC is the name of your watershed, When prompted to "add
ffris shapefile as a theme to yourview," click Yes.

ll.Tum on this theme and rename ft as we did in the first exercise, fo
drop the .shp extension. You may also changethe colorto match the
sfiade of blue used on the otherwater.

12. Make the original Rivers theme active. Choose Delete Themes from
the Edit menu. CIicR Yes to confirm the delete.

13. For the Lakes we will use a quicker process that utilizes fhe
GeoProcessing Wzard. You will first need to turn on this ArcView
Extension. Choose Exfensions from the File menu. Scroll down until
you find GeoProcessing and place a check in the box in front of it"
Click OKto return to your project.

14. Open the Wew menu and select GeoProcessing Wizard. Choose CIip
One Theme Based On Another and Click Next. Choose lakes as ffie
Input theme and your watershed as fhe Clip theme. Click the Browse
button to save the output file as ABC Watershed Lakes, in the same
directory your other files are saved in, When the theme is added,
rename it, adjust its color, and delete the original lakes theme.

ffi Vocabulary

GeoProcessing - The process of
man ipulating and reforming
geographic data.

Shapefile - The file type for
themes that sfore the location,
shape and data for each feature.

Dalabase Access

Didog Dasignat
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Geoproccssing
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15.1n the View menu, selecf Properties. Change the name to ABC
Watershed Lakes E Rivers. Type your name in the Creator box.
Change the Map Units to meters and the Distance Units to miles.

16. Finally, we will create a Layout for use in presentation or display.
You will want to make sure that your watershed fills the entire view.
Make your watershed theme active. Click the Zoom to Active Theme
button. Selecf Layout from the View menu and set up and save your
layout like we did in the first exercise.

17.If you would like to print, from the file menu, click Print. Click Setup
to change your print seffings or select a printer. (Be sure landscape
is checked and printto a color printer if one is available.) Click OKto
send the layout to the printer.

78.Save your Project again by clicking Save Proiectfrom the File menu.
If you are finished for the day exit ArcView, if not continue on the
next exercise.

Data Layers are available on the CD for you to create similar maps that
display county lines, roads, cities. Each of these features is helpful in

understanding how and where the water flows through your watershed
and in working with your project during your monitoring. Now that you
have some basic skills create as many or as few maps as you need.
Review the Exploring Your Watershed skills Rubric at the end of this
lesson the see how you did with your first watershed map.

Application Activitv - Monitorinq Water Qualitv

One of the basic principles of ecology is that everything is
connected. Within your watershed, water can be thought of as one of
the threads holding it together. As each molecule of water makes its
way through the water cycle it is often borrowed by some plant or
animal, only to be returned at some later time. Those untouched,
continue on their journey through your watershed headed to the ocean.

Humans can also interfere with this journey. Sometimes the
water is used harmlessly and returned to the cycle without a scratch.
Unfortunately sometimes in the process of being used the water
becomes contaminated. Water used for irrigation may pick up some
fertilizer or pesticide. Water used in manufacturing might be returned
with traces of heavy metals or other chemicals. Water held behind a
dam to generate electricity might become depleted of its dissolved
oxygen.

,/ Class Discussion: Think about your community and your watershed.
What problems threaten the water quality in your watershed?

W Zoom to Active Theme



Knowing what to look out for will help you to decide what
types of water quality tests you should do and where your

samples need to be taken from. Your testing could focus on

either the chemical properties, biological properties, or the
physical properties of the water. Physical properties are basic
parameters, such as the temperature, turbidity (clarity), and

, stream flow. Chemical properties, such as how much nitrate,
phosphate, dissolved oxygen, or any other chemical is in the

' water. Ultimately, the chemical tests tell you how pure your

water is. Biological properties, such as macroinvertebrate,
i plant, or fish abundance, diversity and composition, can tell you

how the chemical or physical properties are impacting life in the
i water. lt is recommended that you test the same parameters

, from each area.
j

In addition to paying attention to what is going on in the
water. To conduct an effective watershed monitoring program,

, you also need to assess what is happening on the land in your
watershed. After all remember that most rainfall in your

' watershed lands on land. When it rains in yourwatershed, what
,: obstacles will the water face as it makes its way into the surface

or groundwater? Will it have to flow over pavement where it can
pick up oil leaked from vehicles? Or will it land in a forest where
it can nourish the vegetation?

In this activity, you and your instructor will select monitoring sites
for your watershed. We will start by limiting our study to a smaller
watershed within our larger watershed. We will then select sites that
are accessible and will provide useful datia. At this time we will also

create a place for you to store, analyze and display your data. Finally,
you will add the Land Use theme to evaluate how land is used in your

watershed and how it is impacting your water quality.

Open ArcView and open yourwatershed mapping proiect. Clickthe
Views icon in the proiect window. Click New Wew' Click the Add
Theme button and navigate to the directory where you saved the
theme for your watershed in the first exercise. Open this theme and
click OK

Clickthe Add Theme button again to add the smaller watersheds
within your watershed. Navigate to the CD or network directory that
co ntains th e Mo n ito ri ng a W atershed folder. O pen wiwatersheds.shp.

Turn on both themes. Ctrp the wiwatersheds'shp themebased on
your watershed iust as we did with the lakes in the last exercise
using the GeoProcessrng Wizard. Save fhe Outputfile as
* ABC sm watersheds.sh p."

Turn on the new theme. Delete both the original wiwatersheds.sltp
theme and the theme for your watershed. Rename the theme under
Theme Properties and adiustthe color in the Legend Editor.

Add the them* that you created of the rivers and lal<es in your
watershed.

L

H Add Theme
2.

3.

4.

5,



6.

Because traveltime and accessibility may be an issue for your school
district, your instructor will select the smaller watershed that you will monitor.
It would be great if it were possible to monitor the entire watershed. There are
simply too many streams, lakes and rivers in the larger watersheds. You may
want to contact other schools in your area to see if they vrould be interested in
monitoring other smaller watersheds. lf there are enough groups involved, the
entire watershed may be monitored after all!

Use the Selecf Feature tool to selecf the smaller watershed that you
will be monitoring. lt should be highlighted yellow.

Click the ldentify tool and click that same watershed.

What is the name of your watershed?

8. Under the Theme menu, selecf Conveft to Shapefile. Save this file as
XYZ Watershed.shp in the same directory as ffie other files you have
created. (Where XYZ is the name of this new watershed) When
prompted to "add this shapefile as a theme to yourview," click Yes.

9. Make the original watershed theme active and delete it. Make your
new watershed theme active, rename it, and adjust its color.

10. Clip the ABC Watershed Rivers and the ABC Watershed Lakes
themes based on your XYZ watershed using the GeoProcessmg
Wizard. Save the Output file as UXYZ Rivers,shp" and
UXYZ Lakes.shp," respectively.

1l.Delete the original rivers and lakes themes. Tum on, rename, and
adjust the color on your new themes. Make the XYZ Watershd
theme active and click the Zoom to Active Theme button to recenter
and zoom on yourwatershed.

To help us find our way around our watershed we will add the roads and
cities. The roads will be important because many times where a stream
crosses the road is the most accessible place to sample.

12. Add wiroads.shp & wicities.shp by clicking the Add Theme button.
Clip both of these themes using the GeoProcessmg Wizard just as we
did earlier. Delete the original roads & cifies themes once the nsl
themes have been created. Rename and adjust their colors ff you
wish.

With your instructor's guidance decide where you can sample.
You may want to focus your attention on areas that you feel may be
problems, such as down stream from a factory, wastewater treatment
plant, or large farming operation. Do not select more sites that you
have time to sample. lt is also good to test before and after streams
merge. This gives you a better understanding of where pollution might
be coming from.

The easiest way to plot your sites on your watershed map is to
simply pinot and click where you want them. ArcView will then create a
table where you can store your collected data for each site. You can
increase the accuracy of your Iocations by using a Global Positioning
System or GPS. However, this creates more challenges in getting the
points to display properly on your map.

H Select Feature

H ldentify

@ Zoomto Active Theme

H Add rheme

m Vocabulary

Global Positioning Svstem -
24 satellites used to determine
location on the earth's surface
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13.llsing the Zoom In tool, zoom to the area of your watershed where
you wish to add your site locations.

14. From the view menu selecf New Theme..., select Point for your
Feature Type, and name the new theme fesf sffes'shp.

Notice that when this theme is added there is already a dashed line

around the checked box in the Table of Contents. This means that this
theme is in the editing mode.

15. To add your point tocations fo the map click the Draw Point tool. To

get moie accurate placement you may wish to zoom in and out in
fietween sifes, lf you accidentally add too many points, select the
one you wish to delete and use the Delete key. when a point is
setected you may move itto a different location.

16.When all of your points are added selecf Stop Editing from theTheme
menu.

Now you are ready to create the data table that will store all of your

water quality testing data. Before you continue you should know what
you are going to test for and what units it will be measured in.

? tistyour test parameters and their units below.

When collecting data create a simple one page data form with all of the

same table headings to be used in the field. When naming the columns
in your table you will use the season, the year and the parameter and

the unit. For example su04-temp-C, is the temperature in Celsius

recorded during the summer of 20O4. Abbreviate parameter names, but
be sure they are still recognizable.

15. Be sure that the Tesl. Sifes ffreme is sfill active. Ciick the Opur
Theme Table button. Maximize the table window. There should be a
row for every point you placed on the map.

16. From the Table menu selecf Staft Editing. From the Edit menu
choose Add Fietd. Name this new field Site-# and set the width to 8'
Click OK.

17. Click the Edit toot and click your cursor inside of the first site-# box.
Type "7" and then Return. Number all of your sites in this same
manner,

@ Open Theme Table

Parameter Units Parameter Units Parameter Units

@- rinto Definition i;ii

Name: ffi
Type:ffi
Widh: l---T
DecimalPlaces: t-T-

Edit



18. Continue to create fields for each of the parameters that you have
chosen to monitor. Be sure to include the correct number of decimd
places to match the accuracy of your data. If your data is not
numerical, selecf String as the Type. If you make a mistake you will
have to delete the record and create another to replace it. You can
always add or remove fields each season or if you add paramefers.

19. If you already have some data, you may enter that at this time. lf not
it can be added just as we entered the site numbers. When you ane
finished select Stop Editing from the Table menu.

20. When you are finished, rename the view and set the Map and
Distance Units as you did earlier with the other views. Save your
project and close ArcVew .

Analvzinq vour data

Even after only gathering data one time you have enough
information to begin looking for patterns or problems. ls there a site that
has higher figures than all of the others? Was the problem present
upstream? Does the problem continue or disappear down stream?
What might have caused the problem. In this section you will first
change your display to look for problems. You will then add a land use
layer to our map to look for land use pafterns that might have resulted in
the readings that you received.

*"To work through fhese next procedure you must have water quality
data entered into your GIS project. For this first exercise we will
compare all sifes for only one testing season for only one parameter.

1. Open your watershed project in ArcView. Open the view of your
watershed with the fesf sifes.

2. Double-click the lesf Sifes theme name to open the Legend Editor.
Under Legend Type select Graduated Symbol. Under Classification
Field choose fhe parameter field that you wish to analyze. Click the
Classify button and change the Number of Classes to 4. Click OK

Theme: lTEsrElies

, Legend Type, IGraduated S.r,rnbol

, Classification Field: Fm45qJnFi

symbor: Fl sizenanse'[E---- to ne -]
'

Advanced... I statistics... I undo li:::.-::...f,iiplt_.:,....::.ll
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3. If the small dofs are too small
and the larger dofs don't stand
out enough you may want to
change the Size Range in the
Legend Editor. You will also want
fo set the color fo so mething that
sfands out by clicking the Symbol
Box. Click Apply and close the
Legend Editor when you are
finished.
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fH Add rheme

Another option under
Legend Type is Chart. Use
this type to display bar graphs
and pie charts at each
location. These can be very
useful when comparing
multiple parameters or testing
seasons for all sites. Charts
can also be created from the
project window to display any
or all of the data. These
graphs are useful when giving
presentations o r creating
printouts. Of course all data
can also be exported into
Microsoft Excel for further
analysis.

lf any of you r sites
have higher than usual

numbers you may want to contact your local conservation department
or Department of Natural Resources. They may not be aware of any
issues with that body of water. Over the next selteral weeks you may
want to check back to see if the problem has gone away. lf the problem
is persistent looking into the cause and finding a resolution is the next
step. Of counse, to get cooperation it is best not to make false
accusations and come across as if you are against the person who
might be polluting the water. lt is always best to try to work together
with all of those involved to find a solution that works for everyone.

One way to locate the origins of some problems is to study how
we are using the land within the watershed. While in most cases we
cannot change the land use, it is sometimes possible to educate those
involved in using the land to minimize their impact on the watershed.

1. Create a new view of your study watershed with all the same themes
exceptyour study.

2. Click the Add Theme button and navigate to the locations of the
Monitoring A Watershed directory. Add the wilanduse.shp theme.

llsing the GeoProcessing Wzard to clip the land use theme to the
size of your watershed. Save the file as XYZ watershed landuse.shp.
Delete the original land use theme when you are finished.

To getthe new land usetheme fo use the same legend settings as fhe
old you must copy the file "wilanduse.avl," place it in the same
directory where your otherfiles are located, and rename it exactly the
sarne as fhe XYZ watershed landuse file you iust created. Open the
Legend Editor, click the Load... button, selecf the file that you iust
copied and renamed and click OK Click Apply and close the Legend
Editor.

3.

4.



5. Glick and drag the Roads, Lakes, and Rivers themes above the
Land Use theme.

6. Add your test sites theme, make it active and click the Zoom to
Active Theme button.

? Wnat types of land use are present surrounding your test sites?

/ What types of land use are upstre am?

With simple visual analysis you can gain some understanding of
where pollutants might have entered your watershed. With more in-
depth analysis you could calculate the total percent coverage of each
type of land use in your watershed. You could use Select by Theme to
determine which streams in your watershed run through agricultural
land or are within a certain distance from an industrial area or mine.
Once the new information is learned about your watershed, it is now
time to take action to help protect it.

Application - Educate our communitv to protect ourwatershed

1. Get off your duff and do somethingl

All to often we learn about bad things that are happening to our
environment, we get discouraged and think, "Boy, that really stinks!"
We then move on with our lives and unknowingly continue to contribute
to those same problems that we are so concerned about. Worse yet,
we know about the problems we cause and are unwilling to change
anything because it would inconvenience us. Even if we sit by and
watch others unknowingly damage the Earth, we are no better they are
if we sit by and do nothing about it.

lf there is a pollution problem in your watershed and no one is
doing anything to correct it, why don't you! You have already taken the
necessary first steps by establishing a monitoring program. After all,
who is ever going to know there is a problem until you actually look for
one! Continuous monitoring over the years will establish a historical
record of the water quality. You may have data from before and after a
big flood or when a new shopping mall went in. lf you have the data
people will more readily believe that the problem is real. Helping
everyone to recognize the problem should be your first task.

lE Add rheme

W Zoom to Active Theme



2. Educate your Communtty.

Develop a presentation that you can use to share your findings
and recommendations. Include the base maps that you prepared early
in this lesson. These will demonstrate your understanding of the
interconnectedness of our ecosystems and the water they depend on.
Show a map of your sample sites. This will help your audience to see
where the problem is. lnclude digital photographs of you testing the
water. Describe at this time what you tested and how the tests were
conducted. lnclude tables and graphs of data to show what you found.
Explain what hazardous levels of pollution are and what they can cause.
Finally, give your recommendations to resolving the issue. Remember
working together to find solutions that work for everyone is better than
pointing fingers.

Deliver your presentation to groups such as the county board,
city council or other local government body. These people may not
have a direct authority over the watershed, but they are concerned
about issues in their community and they may be able to direct funding
to resolve the problem. lf you have a local conservation department or
natural resources agency consider presenting to them. Present to lake
associations or other environmentally minded organizations. lf you
cannot find a reasonable venue, set up your own meeting and hold it at
school.

Who ever you present to be certain to publicize it well on TV, in
the papers and on posters. Once you start presenting other groups
may contact you to get you to present for them! Other forms of
education can be just as effective. Develop brochures or posters for
distribution. Stencil storm drains to indicate where they are headed so
people think twice about dumping in them. Pass the torch on to new
students by offering assistance or staying involved in the monitoring
efforts. Your gained knowledge is valuable!

Take Action!

Trash Clean Up - Picking up litter helps keep wildlife safe and makes
the stream more enjoyable for human recreation.

Soil Testing - Help homeowners, businesses and farmers determine
how much and what kind of fertilizer they need.

Set Up a Communitv Compost Area - Preventing grass clippings and
yard waste entering streams prevents the addition of extna
phosphorous.

Q Prevent Erosion - ldentify areas that are prone to erosion and offer
assistance in planting the area with native grasses. Shrubs or trees.

@ Learn More! - Visit the Web Links on the next page to find out more
about watershed and water quality.

3.
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Web Links:

C Center for Watershed Science and Education
h tt p : //www . u w s p . e d u /c n r/w ate rs h e d s/i n de x . h tm

C Environmental Protection Agencv Office of Water
h ttp : //www . e p a . g ov/owow/

C Global Rivers Environmental Education Network
h ttp : //www, g re e n . o rg/

C National Water Qualitv assessment Program
h ttp : //w ate r.usgs. g ov/n awq a/

C PalhFinder Science - Stream Monitoring
h tt p : //p a t h fi n d e rs ci e n c e . n eUst re a m rt n d ex . c fm

C Surf YourWatershed
h ttp : //www. e p a, g ov/s u rf/

C Universitv of Wisconsin Lakes Program
h ttp : //www, uw s p, e d u/c n r/uwexl a kes/

C Water Action Volunteers
h ttp : //c I ea n -w ate r. uwex . e d u/w av/

C Water Qualitv in the Great Lakes Resion
hftp ://www. g re at-l akes. n eUenvUw ater/qu al ity. htm I

@ Watershed Action - Center for Global Environmental Education
http ://cg ee. h am li ne. ed u/w atersh ed/acti onrt n dex. htm

S Wisconsin Department of Natural Resource Division of Water
h ftp : //www. d n r. state. wi. u s/e nv i ronm e ntp rotecUw ate r. htm I

Portfolio Planner

Compile the following in portfolio format...

@ Layout of Wisconsin Watersheds

@ Layout of Lakes & Rivers of YourWisconsin Watershed

@ Layout of Your Study Watershed with...
o Rivers & Lakes
o Roads
o Cities
o lesf Sifes

@ Layoutof Land lJseAroundYour lesf Sifes with...
o Rivers & Lakes
o lesf Sifes

@ Sample Tables & Graphs of Your Monitoring Data

@ A Printed Copy of Your Power Point.

@ Gopies of Posters, Brochures, & Newspaper Afticles

O A Self-Evaluation - Monitoring a Watershed Skills Rubric

m References

Proiect ldea:
English, K. 2., & Feaster, L.S.
(2003). Communitv Geoqraphv:
GIS in Action. Redlands, CA:
ESRI Press.

Source Data:
Wisconsin Department of Natural
Resources (1998) GeoDisc 3.0.
Madison, Wl.

Water cvcle lmaqe:
Miller, K. R., & Levine, J. (2002).
Biolosv. Upper Saddle River, NJ:
Pearson Education, Inc.



Monitoring A Wafershed Skt7ls Rubric

skill Excellent Good Needs lmprovement

Internet Searching &
Information source

Scrutiny
(pg 43)

I was able to find my watershed
immediately and gather all of
the necessary information.

I needed assistance finding my
watershed or some of the

information.

I was not able to find my
watershed or any of the

information.

Creating an ArcView
project & editing displays

& data.
(pg.43&44)

I was successful at creating a
project and adding, editing and

displaying theme data.

I needed some assistance
creating a project and adding,
editins and 

::g*ins 
theme

I was not successful creating a
project and adding, editing and

displaying theme data.

Mapping rivers and
lakes in your
watershed.

(pg .47-50)

I was able to clip two themes,
save the new files and create a

layout.

I needed some assistance
clipping two themes, saving the
new files and creating a layout.

I was not able to clip two
themes, save the new files and

create a layout.

Locating a study site and
creating a data storage

theme (pg. 50-54)

I was able to clip two themes,
save the new files and create a

layout.

I needed some assistance
clipping two themes, saving the
new files and creating a layout.

I was not able to clip two
themes, save the new files and

create a layout.

Symbolize data, edit a
map display
(pg. 54)

When displaying the water
quality data I was suc@ssful at

changing the symbols and
editing the map display.

When displaying the water
quality data I needed some

assistance changing the
symbols and editing the map

display.

When displaying the water
quality data I was not

successful at changing the
symbols and editing the map

display.

Geoprocessing, orga nize
and manage files,

inferring land use impact
(pg. 55-56)

I was successful at clipping the
land use them to my watershed

and saving the new theme.

I needed some assistance at
clipping the land use them to
my watershed and saving the

new theme.

I was unsuccessful at clipping
the land use them to my

watershed and saving the new
theme.

Community Education
(pg. 56 & 57)

I participated in creating or
delivering presentations. To the

community.

I participated in only one of the
activities.

I did not participate in either
activity.

Citizen Action
(pg 56 & 57)

I participated in some action
projects to help protect our

watershed.

I participated in one action
project to help protect our

watershed.

I did not participate in any
projects to help protect our

watershed.



Conceptual Framework

Understanding our Environment with G/S is focused on building knowledge

about environmental concepts through the use of GlS. The curriculum is built on

modular lessons that can stand-alone or be put together for a larger unit. The use

of GIS in studying the environment is a natural fit. GIS encourages exploration of

spatial information to find patterns using multiple intelligences. GIS provides

students with another tool to tackle problem-solving. Not only do they have to find

information, they have to know what to do with it. Using GIS in the classroom

provides teachers an avenue to employ student centered learning. When used in

the K-12 setting GIS also becomes a vocational tool as countless industries rely on

GIS everyday.

Theme:

Understanding our Environment with G/S focuses on environmental concepts in

which spatial relationships can be examined. This first three lessons look at how

living things are distributed in the world. The last two examine how human use of
the land impacts the environment. Understanding how our world exists and

functions today will allow students the opportunity to predict and plan how it will

exist in the future.

Kev Goncepts bv Lesson:

Q Where in the World
o Biomes are major regions of the world with a certain plant & animal composition
r The distribution of life on Earth is governed by many biotic & abiotic factors
. Organisms adapt to living in specific environmental conditions through natural

selection
. Organisms faced with environmentalstress must move, adapt, or die off
o Human activity impacts the factors that affect species distribution

Disappearing Reefs
o Coralree6 are ecologically and socially important ecosystems
. Coralreef face threat both caused by humans and natural

Tracking Sea Turtles
o Animals posses a home range in which they spend most of their lives

o Biologists study animal movements to better understand their behavior

/F-\\7
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Conceptual Frarnework

Kev Concepts bv Lesson 
= 
(continued)

S Estimating lmpervious Surfaces
o Precipitation falls into surface water, infiftrates the soil or runs off of impervious

surfaces
o Humans land use has increased the amount of impervious surfaces

o Precipitation falling on impervious surfaces is more likely to become polluted

o Too much impervious surface within a watershed a serious impact

@ Monitoring A Watershed
o The hydrologic cycle involves the movement of water through an ecosystem

o The area of land that drains into a body if water is its watershed

o A watershed for a large body of water is made of many smaller watersheds

e The quality of water is depended upon physical, chemical, and biologicalfactors

r Monitoring water quality should be an on-going activity

o Human land use impacts water quality



Processes, Skt7ls & Obiectives
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Proce$ses, Ski/ls & Obiecfi'ves
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Processes, Sk//s & Obiectives
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Glossary

Abiotic - Non-living

Biogeographv - The study of specles distribution

Biome - A geographic region with similar climate and species composition

Biotic - Living

Climatoqram - A graph thatdisplays the average monthly precipitation and the average
monthly temperature.

Condensation - To change from a gas fo a liquid

Digitizing - The process of obseruing a feature on an image and outlining its perimeter to
convert it to a feature

Endemic - A species that is limited in distributions to only one location

Evaporation - To change from a liquid to a gas

GeoProcessino - The process of manipulating and reforming geographic data

Global Positioninq System - 24 satellites used to determine location on the eafth's surface

lmpervious Surface - Any surface which does no allow water to soak in

Lavout - An arrangement of map .elements for printout or digital display

Natural Selection - The process where the conditions in the environment determine which
organisms will survive & reprcduce

Nonooint Source Pollution - Pollution that comes frorn a variety of sources that are not directly
identifiable

Precipitation - Any form of rain, snow, sleet, etc.

Proiect - An ArcView file that organizes your data & products

Reqistration file - A file that align two or more maps or images so that equivalent geogrcphic
coordinates coincide.

Root Uptake - Plant absorbing water into their roots

Runoff - Water moving across the landscape, not soaking into the ground

Seepaqe - Water soaking into the ground

Shapefile - The file type for themes that store the location, shape and data for each feature

Theme - A sef of related geographic features in point line or polygon format

Transpiration - Evaporation of waterfrom the leaves of plants

View - The map area and a table of contents of available data layers

Watershed - The area of land that drains into a common body of water
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